. /| #
~/ -
— "
N

Last updated on 03/23/2021



Melodyne 4 editor - DAW without ARA

The Melodyne Help Center and this PDF document

This PDF document was generated automatically from the contents of the Melodyne Help Center. It
contains what, on the date indicated on the front page, were the latest versions of the text and
images.

You will find the comprehensive and invariably up-to-date Melodyne Help Center along with
numerous films and inspiring tutorials, as well naturally as the latest version of this PDF document, on
our web site. Why not take a look? Just follow the link at the foot of each page of this PDF.
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activation. < | would like to install Melodyne again but no longer have the installation program. « I'm not sure

whether the right edition and version of Melodyne is running. « | would like to know whether an update is

available for my Melodyne. ¢ | cannot launch the stand-alone implementation of Melodyne. ¢ | have inserted

Melodyne as a plug-in in one of the audio tracks of my DAW but nothing is happening. ¢ | have the impression
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alone implementation of Melodyne. < After transferring or importing audio, the blobs in Melodyne are not at all

as | expected. « Sometimes, | can only move the blobs in the Note Editor vertically, sometimes only

horizontally. + When [ shift the pitch of certain blobs, they sound unnatural. « In the stand-alone

implementation, the tempo of an imported audio file is wrong.
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In this tour, you will learn how to transfer audio material to the plug-in implementation of Melodyne as
well as the fundamentals of its use.

How Melodyne works

Before it can make its editing functions available to you, Melodyne must first analyze the audio
material. Since for this analysis the audio file has to be examined as a whole, it cannot be conducted
in real time; it is performed once only, at the start, before the first blobs appear in the Note Editor. In
the stand-alone implementation of Melodyne, this is when the audio file is first opened.

In the case of the plug-in, the matter is somewhat more complicated. Since most commonly-
encountered plug-in interfaces are designed for pure real-time operation, a plug-in, logically enough,
is only shown the part of the audio file that is being played at that instant, which is rather like looking
through a keyhole. But Melodyne, as we have seen, requires a more comprehensive overview; for
this reason, you have to send it in advance the track segments you wish to edit, so that it can study
them.

This is the purpose of what we call the “transfer”: This is essentially a recording process whereby the
plug-in implementation of Melodyne makes its own copy of the track segments playing back in the
DAW. In this way, Melodyne obtains the audio data that it must have if it is to detect and display the
notes. These transfers make using Melodyne more effort than one would like, but there is no other
way of overcoming the limitations of real-time plug-in interfaces.

There are, of course, exceptions: To make working with Melodyne in a DAW more effortless, we have
developed the ARA plug-in interface extension. DAWSs that support ARA provide Melodyne with all the
information it needs about the audio files they are using and make it possible to open a track for
editing in Melodyne immediately — i.e. without going through the transfer procedure first. This is the
most convenient way of using Melodyne in a DAW.

If your DAW supports ARA, apart from the next paragraph, the rest of this tour need not concern you.
Instead, search for your DAW in the Help Center, where you'll find details of how to take advantage of
ARA with each of the various DAWSs that support it.

The following, however, applies to all scenarios involving Melodyne — with or without ARA: The
amount of memory Melodyne requires depends partly upon the length of the files you are transferring
to it or loading but mainly upon the number of notes they contain: the more notes a file contains, the
longer the detection process takes and the more memory it requires. This makes it difficult to
formulate a concrete rule, but, in general: with files longer than an hour, the detection process is
generally slow; files longer than two hours, however, may be impossible to load or transfer at all, due
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to shortage of memory. In such cases, please divide the file up and transfer or load only the
segments that you actually wish to edit in Melodyne.

Transferring audio to the plug-in implementation of Melodyne

Open in your DAW the project you wish to edit.

Load the plug-in implementation of Melodyne as an audio insert effect in the audio track containing
the material you wish to edit. Position the plug-in implementation of Melodyne above any insert
effects you may be using in the track — if in doubt, put it in the first insert slot. For the analysis (or
“detection”) to achieve the best possible results, Melodyne needs to be given as dry and clean an
input signal as possible.

® Move the playback cursor in the DAW to a point before the beginning of the passage you wish
to edit with Melodyne.

® Click the Transfer button at the top left of the Melodyne window to prepare it to accept the
transfer.

{ .Traﬂ\sler : 83 o | = \'

® Press Play in the DAW to transfer the material, which Melodyne will import automatically.
Press Stop when the end of the passage you wish to edit is reached.

Stopping the DAW playback automatically brings to an end Melodyne’s transfer readiness. You can
also interrupt a transfer in progress at any time by clicking the Transfer button.

If you wish, you can transfer to Melodyne further passages from different parts of the DAW track.
Clicking the Transfer button during playback by the DAW toggles Melodyne’s “enable transfer”
function on and off, allowing you to punch in and out as the playback proceeds. Alternatively, as you
reach the end of each of the passages you wish to transfer you can stop playback by the DAW, find
the start of the next passage, transfer-enable Melodyne again, restart playback by the DAW, stop it
again, and so on. If you wish, you can just transfer the entire track or even several tracks
simultaneously to multiple instances of Melodyne. To do this, simply enable the Transfer buttons of all
the instances to which you wish to transfer material simultaneously.
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Important: If your DAW project contains changes of tempo or time signature, please consult the tour
entitled “Adjusting to tempo variations in the DAW”.

Tip: Initialize the key prior to the transfer: In the case of monophonic or polyphonic audio material,
Melodyne also recognizes the key (or “tonality”) of the music. With short melodic phrases, however,
the key chosen is often not the one intended, simply because too few notes are available for a correct
appraisal. To prevent this happening, you can set the key using the Scale Ruler of an empty instance
of the plug-in or an empty document (if using the stand-alone implementation of the program) before
the transfer or loading of an audio file. To do this, simply click on the desired keynote in the Scale
Ruler and select the desired scale or key from the context menu. Melodyne will then retain this
initialized value, regardless of its own subsequent analysis.

Replace Ranges

During playback, those passages that have been transferred to Melodyne will be played back by
Melodyne; all others by the DAW. In other words, wherever it has material to play back, Melodyne’s
signal will replace that of the original track.

From the Options > Note Editor sub-menu, choose Show Replace Ranges. All the passages that will
be played back by Melodyne (as opposed to the DAW) will now be marked. Such regions can be
extended simply by dragging their borders with the mouse.
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To shorten a playback region, delete a few blobs and select Set Replace Ranges to Notes from the
context menu of the Time Ruler. This command works not only at the borders of the playback region
but also when you delete notes from the middle of the region — as shown in the following illustration.
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The Project Browser shows you all the audio files used by each project and helps you manage them
and locate missing files.

Opening the Project Browser

Both the stand-alone implementation and the plug-in possess a Project Browser. In each case, this is
opened by clicking the “Project” tab in Melodyne’s info pane.

Note Project File

k

>

The Project Browser and transfers in the plug-in

In the plug-in implementation of Melodyne, the Project Browser displays a file entry for every
Melodyne transfer from the DAW that has been conducted.

The Melodyne plug-in records the audio material transferred from the DAW track, creating audio files
in the process that it stores on your hard disk. For material to be played back and edited in Melodyne,
it is not enough simply for the original audio files to be present in the DAW project; Melodyne also
requires its own audio files — the ones it created at the time of the transfer.

It is important to remember this when you wish to archive a DAW project or pass it on to another user
complete with your Melodyne editing. In this case, you must be sure to archive or hand over not only
the DAW project along with its audio and other files but also the transfer files created by Melodyne.
Otherwise, when the archived project is restored or when the recipient comes to open it, the
transferred passages and the editing you have applied to them will be inaccessible.

The question that arises, therefore, is this: Where does Melodyne store the files it creates and how
can you append them to your project? The answer is found in the Project Browser, which allows you
to manage the transfer files and also search for lost ones.
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The Project Browser of the plug-in allows you to choose the folder in which the transfers will be kept.
To do this, click on the cog icon near the top right-hand corner of the Project Browser and choose Set
Path for Transfers. Your choice applies only to the current project. We recommend, therefore, that
you choose a folder within your DAW'’s project folder as the path for transfers, as this will make both
archiving and passing on the project to others more straightforward.

You can set the path for your transfers at any stage in the editing process. As soon as you do so, all
the transfers created up to that point in the course of the project (and stored in Melodyne’s temporary
transfers folder) will be moved to the folder you have selected. Whether the new folder is on the same
or a different volume (e.g. a different hard disk) makes no difference; the existing files will be copied
to the new location. New transfers will be stored in the newly created folder.

Each time you set a new path for transfers, Melodyne tells you to save your DAW project so that the
new file references can be stored in a permanent fashion.

Automatic selection of the path for transfers

Many DAWSs are able to tell Melodyne where the folder of the current project is located. In these
DAWSs, you are not offered the option of specifying a different path. Instead, Melodyne automatically
stores its transfers in the project folder created by the DAW, thereby ensuring that your transfer files
are integrated into the project and do not get lost.

Do not worry, then, if your DAW offers you no way of choosing a path for the transfers. If that is the
case, Melodyne will store the files in question in the right place automatically.

Unused and missing audio files

In both the stand-alone implementation and the plug-in, audio files are color-coded in the browser as
follows:

® Black: The file is present and being used by the project
® Gray: The file is present but not in use (e.g. because you have deleted from the project all the
notes it contains)
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® Red: The file is needed but unavailable

The reason unused files are retained in the Project Browser rather than being deleted automatically is
that this allows you to undo the delete operation, which would otherwise be impossible.

If Melodyne cannot find one of the files it needs to use — either because it has been deleted or
because it was not moved to a new computer along with the other project files — the missing file will
be shown in red in the Project Browser. The notes belonging to such a file are shown in gray with a
red outline in the Note Editor and are muted during playback.

A 3ADE9F3A-956...4AB1487.wav

A 52BBFBA0-584...A609479.wav c J

Commands in the drop-down and context menus

The drop-down menu opened by the cog icon in the Project Browser as well as the context menu in
the same browser offer the following commands, some of which are designed to facilitate the
assignment of missing files.

Set Path for Transfers... (only in the plug-in): This allows you to specify where the transfer files
should be stored, as is explained above.

Show in Finder/Explorer: If you choose this command after right-clicking on a file in the Project
Browser, a Finder/Explorer window will open showing you the location of the file.

Copy File(s): This copies the selected file(s) onto the clipboard. This might be useful, for example, if
you have passed on to another user a project missing one or more of the requisite transfer files; by
selecting the missing file(s) in the Project Browser, choosing Copy File(s) and then pasting the
contents of the clipboard onto a hard disk or other storage medium, you can remedy the error swiftly
without having to hunt around for the missing file(s).

Copy Path for File(s): This copies as text to the clipboard the path of the selected files. This is useful
if you need to send someone a list of missing files.

Find Missing Files: This opens a file selection window that allows you to locate the missing file on
your hard disk and “show” it to Melodyne.

It is advisable to save your project after reassigning files, in order to store the updated references.

Copy External Files to Project Folder (only in the stand-alone implementation): This command
results in all the files that you have imported into your project from different locations on your hard
disk, whether via the File menu or by drag ‘n’ drop, being copied into the audio folder of your
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Melodyne project. This folder, which is created when your Melodyne project is first saved, is on the
same level in the file hierarchy, and bears the same name, as the MPD file of the project, but with the
suffix “_Audio”. It is advisable to save your DAW project after executing this command, in order to
store the updated references.

Delete Unused Files in Project Folder: If you are certain that you will have no further need for files
marked as unused in the Project Browser, this command allows you to delete them and liberate
space on your hard disk.

The last two commands in the context menu allow you to specify whether the files in the Project
Browser should be displayed in alphabetical order or according to status (missing, used, unused).
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This tour will give you an overview of the functions Melodyne offers for navigation and the playing
back of audio.

Controlling playback using the keyboard and transport bar

The plug-in implementation of Melodyne is integrated into the DAW and keeps perfectly in step with
its playback. When you reposition the DAW, this information is conveyed to Melodyne, which mirrors
the new position. As soon as the DAW starts, Melodyne also starts. It is not possible to start, stop or
reposition the DAW’s playback cursor from within Melodyne.

With the stand-alone implementation of Melodyne, you start and stop the playback using the buttons
in the transport bar at the top or by pressing the space bar. If you hold the [Alt] key at the same time,
playback will be confined to the current selection.

T —
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You can also control playback in Melodyne Stand-Alone using the numeric keypad of your computer.
The shortcuts can be selected from the Preferences dialog, the default settings being as follows:

® Playback/Pause [space bar]: Stop or Start playback from the current position of the playback
cursor

® Start [Enter] when stopped: Commence playback from the current position of the playback
cursor

® Start [Enter] during playback: Jump to, and continue playback from, the last starting point

® Stop [0 on the numeric keypad] during playback: Stop and jump to the last starting point

® Stop [0 on the numeric keypad] twice in succession: Jump to the beginning of the project

In both the stand-alone and plug-in implementations of Melodyne, the arrow keys on the keyboard
can be used to step through the blobs. When playback is stopped, the blob currently selected will
sound.

Please note that you can define a wide variety of keyboard shortcuts — including new playback
shortcuts — using Melodyne’s Preferences dialog. If for any reason you are not satisfied with the
default shortcuts, you can redefine them at will.

Controlling playback, scrubbing and zooming using the Time Ruler

The following playback functions are available in both the stand-alone and plug-in implementations of
Melodyne — in the Melodyne plug-in, however, only when the DAW is stopped; as soon as it starts
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again, Melodyne plug-in resumes its shadowing of the DAW as described earlier.

Double-click in the Melodyne Time Ruler (or directly in the background of the Note Editor) to
commence playback from the position in question. If you hold down the [Alt] key as you double-click
in the Time Ruler, playback will be confined to the current selection.
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Click in the Time Ruler to move the playback cursor to the position in question and halt playback at
the same time.

Click and drag in the Time Ruler to scrub through the audio material.

By dragging upwards or downwards, you can zoom the display at the current position. Scrubbing and
zooming can be used in combination, allowing you to navigate and position the cursor intuitively,
setting the zoom factor at the same time.

Resizing the window

To change the size of the window, click and drag the bottom right-hand corner. The procedure is the
same for both the stand-alone and plug-in implementations of Melodyne.

Scrolling and zooming in the Note Editor

Select the Scroll Tool (the hand icon) from beneath the main tool or hold down the [Command] and
[Shift] keys to move the display area with the mouse.
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Select the Zoom Tool (the magnifying glass) from beneath the Main Tool or press [Command]+[Alt] to
zoom the display with the mouse. You can zoom horizontally and vertically at the same time — with
different levels of intensity in each case.

@*
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[Command]+[Sh|ft]+double—cI|ck zooms in on one blob or several (if several are selected). A
corresponding double-click in the editing background returns you to the previous zoom level.

If your hardware supports the corresponding functions, you can also scroll and zoom with the mouse
and trackpad:

® The mouse wheel and swiping with two fingers on the trackpad can be used for horizontal and
vertical scrolling.

® Pinching with two fingers on the trackpad zooms the display simultaneously on the horizontal
and vertical planes.

Drag the horizontal or vertical scrollers (i.e. the scroll boxes or ‘thumbs’) to move the display. The
horizontal scroller contains a miniaturized image of the contents as an orientation aid.

> ODDRON-SN B S B B CcHEaEnEe-»e

")

Drag the ends of the scroller to zoom the display.
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If you are editing a particularly long audio file, you may find the reduced size of the scroller makes it
difficult to achieve the desired zoom resolution. In that case, you can zoom in further by holding down
the [Command] and [Alt] keys whilst dragging in the edit pane or else by dragging vertically in the
Time Ruler.

If you pull one end of the horizontal or vertical slider as far as it will go and hold it, you can increase
the vertical or horizontal size of the area displayed. This can be useful in the plug-in, for example,
when you have only transferred the first three bars (measures) of your material but wish to insert
something at bar 20.

Double-click in the center of the scroller to zoom in or out just enough to ensure that all the blobs are
displayed. If cycle mode is active, double-clicking on the horizontal scroller zooms the display just
enough to ensure that the entire contents of the cycle range are visible.
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Use the slider in the bottom right-hand corner near the Note Editor to alter the height of the blobs.
This does not alter their volume. Your likely motive will be to obtain a clearer view of material
containing a lot of particularly quiet or particularly loud notes.

A note about automatic scrolling in the Note Editor

If you have selected one or several notes, Melodyne assumes that you wish to see and edit them,
and exercises the requisite restraint by deactivating the auto-scroll function temporarily. Only when
you deselect the notes (for example, by clicking in the background of the Note Editor) and restart the
playback does the display resume its pursuit of the playback cursor.

Similarly, if you move the horizontal scroller so far during playback that the playback cursor actually
disappears from the screen, automatic scrolling will be deactivated. Stopping and restarting in this
case will reactivate the auto-scroll function.

If automatic scrolling has temporarily been deactivated, the auto-scroll icon in the bottom right-hand
corner of the Note Editor takes the form shown here.

-~— —
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Navigation and zoom functions

® To resize the window (also in Plugin), drag the bottom right corner

® Hold down the [Command]+[Shift] keys and drag the editing background of the Note Editor to
move the area displayed

® Use the mouse wheel to scroll up and down or else (holding the [Shift] key) left and right

® A two-finger swipe on the trackpad can be used to scroll the display

® A two-finger pinch on the trackpad can be used to zoom the display.

® [Command]+[Alt]+drag in the Note Editor serves to zoom the display horizontally and/or
vertically

® Drag vertically in the Time Ruler to zoom in on the area indicated

® Press [Command]+[Alt] and use the mouse wheel to zoom both axes simultaneously

® Press [Command] and double-click to zoom in on a blob or the current selection of blobs

® [Command]+double-click in the editing background to restore the previous zoom setting

® Drag the scrollers to move the display horizontally or vertically

® Drag the ends of the scroller to zoom the display horizontally or vertically

® Pull the left- or right-hand ends of the horizontal slider as far as they will go to increase the
length of the section displayed (important in the plug-in e.g. when you have only transferred
the first four bars and are able to navigate only in this area but wish to insert something at bar
20)

® Double-click the scrollers to zoom in or out horizontally or vertically until all notes are displayed

® The slider in the bottom right-hand corner governs the height of the blobs
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Cycle mode

In Melodyne’s cycle mode, a selected passage is repeated endlessly.

Defining the cycle range

To define a cycle range, click and drag in the lower part of the Time Ruler. If, as you do so, you hold
down the [Alt] key, the Time Grid will be ignored, allowing you to position the start and end points
(which we call the “cycle locators”) freely.

62 163
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Switching cycle mode on and off

Double-click on the cycle range in the narrow strip immediately below the Time Ruler to toggle cycle
mode on and off. When cycle mode is active, the cycle range is shown in dark grey

—e .,

In the stand-alone implementation of Melodyne, you can also switch cycle mode on and off from the
transport bar.

| (] (el=(f ) 6032 || w - e

It is also possible by choosing File > Preferences > Shortcuts to define a keyboard shortcut for
toggling cycle mode on and off.

Changing the length of, and moving, the cycle range

Drag the right- or left-hand locators to alter the length of the cycle range. If, as you do so, you hold
down the [Alt] key, the Time Grid will be ignored, allowing you to position the locators freely.
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Drag the middle of the cycle range to move it ‘en bloc’ to the left or right. If, as you do so, you hold
down the [Alt] key, the Time Grid will be ignored.

-»—\7‘

If you [Shift]+click near either of the cycle locators, it will move to the designated position. If, as you
do so, you hold down the [Alt] key, the Time Grid will be ignored.

Defining the cycle range using a blob selection

To move the cycle locators to the beginning and end of the current blob selection (snapping to the
grid) hold the [Shift] key and double-click anywhere in the cycle range. If you hold the [Alt] key as well
as the [Shift] key as you do this, instead of snapping to the grid, the locators will be placed at the
beginning of the first, and end of the last, blob in the selection.
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Display and other options

Melodyne offers for the user interface and working in the Note Editor various options that allow you to
adapt the appearance and behavior of the program to your tastes.

Showing and hiding elements of the user interface

Melodyne’s user interface can be adapted to a variety of different work situations and demands. You
will find the means of doing so in the Options menu as well as the interface itself.

S AL AN s T R

® “Show Scale Editor” (A): Shows/Hides the three Scale Editor columns.

® “Pitch Grid Settings” (B): Offers the choice between various options for the Pitch Grid.

®* “Time Grid Settings” (C): Offers the choice between various options for the Time Grid.

® “Show Info Pane” (D): Shows/Hides the info pane.

® “Auto Scroll” (E): When this option is selected, the display in the Note Editor follows the
playback cursor.
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A note about automatic scrolling in the Note Editor: If you have selected one or several notes,
Melodyne assumes that you wish to see and edit them, and exercises the requisite restraint by
deactivating the auto-scroll function temporarily. Only when you deselect the notes (for example, by
clicking in the background of the Note Editor) and restart the playback does the display resume its
pursuit of the playback cursor.

Similarly, if you move the horizontal scroller so far during playback that the playback cursor actually
disappears from the screen, automatic scrolling will be deactivated. Stopping and restarting in this
case will reactivate the auto-scroll function.

If automatic scrolling has temporarily been deactivated, the auto-scroll icon in the bottom right-hand
corner of the Note Editor takes the form shown here.

All the options described below relate to the Note Editor and are found by choosing Options > Note
Editor Options from the main menu or by clicking the cog icon in the top right-hand corner of the Note
Editor.

Please note that these options can be selected independently for Edit and Note Assignment modes.

Show Pitch Curve

If you check the option Show Pitch Curve, a thin line tracing the exact pitch of the tone at each instant
will be superimposed on the corresponding blob.

On the left, you can see the ‘naked’ blobs (with none of the Note Editor display options selected) and
on the right, the same blobs with the Show Pitch Curve option checked.
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Regardless of whether or not this option is checked, the pitch curve will be displayed whenever the
Pitch Tool is selected.

Show Note Separations

If you select the option Show Note Separations, gray vertical lines appear at the beginnings and
endings of notes indicating their limits or separations.

Note Separations are either shown as lines (soft separations between connected notes) or thin
brackets (hard separations).
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Note separations are always displayed when the independent Note Separation Tool is in use,
regardless of whether or not the menu entry is checked.

Show Note Tails

In the detection and display of notes, Melodyne editor draws a distinction between the notes
themselves and their tails — notes being the events of musical relevance and tails depicting the non-
musically-determined fading-away of the sound. The share of the reverberation ascribed to a given
tone, for example, is reflected in its tail. The Show Note Tails option allows you to decide whether the
reverberative phase of notes should be displayed or hidden. This is likely to depend upon whether
you prefer to concentrate upon their musical or their acoustic aspects.

A
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If the tail is not displayed, the end of the musically relevant part of the note provides the handle you
can drag with the Time Tool to make the note longer or shorter. Any reverberation present will in this
case automatically be governed by the changes made. This display option serves to provide a clearer
overview of the intended musical events.

If the note tail is displayed (assuming it has one), it is this that provides the handle for the Time Tool.
Show Note Talils is the option most suitable when what is sought is as authentic a picture as possible
of the sounds actually heard — including any reverberation present.

Show Blob Info

With the option Show Blob Info, you can elect to show or hide a variety of display elements designed
to facilitate working with individual notes.
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The most striking of these elements is the Local Pitch Ruler that appears directly in front of any note
over which you move the mouse pointer. Within the blob itself, thin lines mark the drag zones for the
context-sensitive tools.

If you drag a blob when the Show Blob Info option is checked, a vertical line also appears in the Time
Ruler aligned with the exact start of the note. This makes more precise positioning possible.

Show Intended Notes

If you check the option Show Intended Notes, gray frames appear around each blob.

These invariably lie directly on the semitone and coincide exactly with a gridline. They represent, in
other words, Melodyne’s assumptions (based on its own analysis of the audio) as to the intended
pitch of the note and its intended position within the measure or bar. These assumptions generally
turn out to be correct, but are not inevitably so. They are to be thought of as suggestions.

The frames also display the positions in pitch and time towards which the notes in question will
gravitate if partial quantization is applied to them with the macros, which are also the positions they
will snap to if you double-click on them with the Time Tool or Pitch Tool.

Highlight Notes During Playback

With this option, you can select whether or not you would like your eye to be drawn to the note
currently playing back. Highlighting is mainly useful when the screen is thick with notes.
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Show Replace Ranges (in the plug-in implementation only)

If you check this option, those passages will be indicated that have been transferred to the plug-in
from your host and for the playback of which, in consequence, Melodyne rather than the host is
responsible.

This information is conveyed by the fact that the Time Ruler is shaded more palely for the duration of
all such passages.

|9 |10 11 %127
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Monitor When Editing Blobs

When you shift the pitch of blobs in the Note Editor with this option selected, Melodyne plays for the
purpose of orientation the sound of the note at the position originally clicked. You can turn this
acoustic feedback on or off.
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From the Preferences property sheet, you can select fundamental options governing the modus
operandi of Melodyne as well as define a number of keyboard shortcuts.

Opening the window and general settings

In the plug-in implementation of Melodyne, you open the Preferences property sheet from the
Settings menu; in the stand-alone implementation, choose Preferences from the program (macOS) or
File (Windows) menu. The settings available in the stand-alone implementation differ slightly from
those offered by the plug-in.

Language: | English
Pitch labels: | German

Look: | Default

Default tuning:  440.0 Hz
Maximum undo levels: 25 $

v/Show tooltips

The following options, however, are available in both implementations of Melodyne. Any changes you
make in either implementation apply to both.

® | anguage: Determines the language of the user interface.

® Pitch labels: Determines which system is used to name the notes —i.e. (descending
chromatically) English (C, B, Bb etc.), German (C, H, B etc.) or Latin (Do, Si, Sib etc.).

® Appearance: Here you can select between different contrast settings for the user interface.

® Default tuning: Determines the frequency of the reference pitch A4 (the A above Middle C).

® Maximum undo levels: Melodyne allows you to undo up to 100 actions. The default value,
however, is 25. You can, if you wish, increase this value, which will consume more RAM, or
you may prefer to reduce it, if memory is running short.

® Show tooltips: Once you are thoroughly familiar with Melodyne, you may prefer to hide the
tooltips, i.e. the explanatory text that appears as you move the cursor over the various icons
and other elements of the user interface.

Audio and recording preferences

In both the stand-alone implementation and the plug-in, you will find the following two options:

® Audio cache: Determines the location on your hard disk of the audio cache Melodyne editor
requires for internal processing.
® Audio cache size: Determines the maximum size of this audio cache.
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The following option is only found in the plug-in:

Detect audio after transfer

® Detect audio after transfer: When this option is selected, the detection (analysis) of the audio
material does not begin until the transfer is complete, thereby reducing the CPU load during
the transfer. Select this option if your computer is not especially powerful and there are
indications during the transfer that its resources are becoming overstretched (e.qg. clicks, drop
outs, extreme slowing-down of the system).

Audio

Audio device: Mikrofon + Ausgang (integriert) H
Sample rate: 44,100 kHz

Buffer size: 512 Samples

Ignore buffer underruns
Master output:  1-2 $
Default input:  1-2 $

The Audio and Recording pages of the Preferences property sheet display the following additional
options:

® Audio device: allows you to select an audio driver or the audio hardware driven by it.

® Sample rate: determines the sample rate used by Melodyne.

® Buffer size: determines the size of the buffer used for audio editing. The smaller the value, the
lower the latency but the greater the load on the CPU.

® Ignore buffer underruns: If Melodyne Stand-Alone is running on a slow computer where the
possibility of an overload (and an ensuing click or dropout) exists, by checking this box, you
inform Melodyne that you consider the former to be the lesser of the two evils — the point being
that audio hardware is often very sensitive to dropouts and can even in such cases cause the
entire computer to crash. Check the box if ever this happens. Such occurrences are very rare,
however, and most users can safely ignore this option.

® Master output: selects the main output for Melodyne stand-alone. The level at this output is
controlled by the Master Volume control in the transport bar. If your audio hardware only offers
one output, this is automatically the Master output

® Default input: selects the main input for Melodyne Stand-Alone. If your audio hardware only
offers one input, this is automatically the Default input.

® Audio file format: determines the file format used by Melodyne to store recordings. The most
commonly used formats are WAV and AIFF.

© Celemony Software GmbH 2021 « Last updated on 03/23/2021 « Help Center « www.celemony.com 28



http://helpcenter.celemony.com/hc-2/?lang=en&startPageEdition=melodyne-editor
http://www.celemony.com

Melodyne 4 editor - DAW without ARA

Shortcuts

The Shortcuts page of the Preferences property sheet allows you to customize the keyboard
shortcuts used by Melodyne for a wide range of functions.

Click the triangle to the left of the category that interests you in order to see a list of the available
commands.

Click on a command and then press the key or combination of keys that you wish to assign as its
shortcut. Melodyne will assign the key or combination of keys to the command in question. Repeat
the procedure for as many commands as you like.

To remove an unwanted shortcut, select the command in question followed by Delete. You can
restore the factory defaults at any time by clicking the Reset button; you will be asked to confirm that
this is your intention.

The Export and Import buttons allow you to save one set of keyboard shortcuts to a storage device
and reload a set saved earlier. In this way, you can carry your shortcut preferences around with you —
on a USB stick, for example — when moving from studio to studio.

Check for Updates

On this page, you can determine whether Melodyne checks for updates automatically or manually i.e.
only when you click the ‘Check Now’ button, which you can do at any time.
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For the display and editing of different types of audio material, Melodyne employs different
algorithms. Here, we outline which algorithms are available and for which types of audio material
each is used.

The detection process

Melodyne analyzes the audio material to find the notes it contains and offer them to you for editing.
We call this process “detection”.

In the course of the detection process, Melodyne itself takes a view as to what kind of material it is
confronted with and decides which algorithm to use for the display and playback of the notes. You
can tell which algorithm is selected at any given time by the check mark in the Algorithm menu as well
as by the blobs in the Note Editor. Please bear in mind, however, that the detection process —in
particular in the case of polyphonic audio material — cannot, for reasons that have to do with
immutable principles, always deliver perfect results. Since a musically correct analysis of the recorded
material is the most important precondition for efficient editing and convincing acoustic results, we
recommend you to check the results of the detection systematically and make whatever corrections
are necessary.

The Melodic algorithm

Melodic material is monophonic, by which we mean it is such that only one note is ever sounding at
any given instant. Please bear in mind, however, that reverberation can cause notes to overlap even
in monophonic material, creating, in effect, a kind of polyphony. If melodic material is to be edited in
Melodyne, therefore, you should aim for as clean and “dry” (reverberation-free) a recording as
possible.

The blobs representing notes in melodic material are displayed at different pitches. Whether the blobs
are isolated or joined to other blobs depends on the way they were played or sung: staccato or legato.
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The Percussive algorithm

This category includes not only recordings of drums and other percussion instruments but also noise
and atmospheric effects as well as other material in which Melodyne cannot detect any clear pitch in
the sounds. When the Percussive algorithm is selected, successive drum strokes (for example) are
distinguished, but they are all displayed at the same pitch. The blobs can still be raised or lowered in
pitch, but the pitch ruler does not display the names of any notes but simply relative values in
semitones. The scale functions are deactivated.

SEE ST S S G - S S

The Polyphonic (Sustain/Decay) algorithm

In Melodyne, thanks to DNA Direct Note Access, notes can be detected and edited within recordings
even of polyphonic instruments such as the piano or guitar — including the individual notes of which
chords are composed. When the Polyphonic algorithm is used, the blobs are displayed in a similar
manner to those of monophonic material, with the obvious difference that the blobs are stacked
vertically (at their respective pitches) whenever a chord or harmonic interval sounds.

There are two versions of the Polyphonic algorithm:
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® Polyphonic Sustain is the algorithm with which users of earlier versions of Melodyne are
already familiar and is suitable for a wide range of polyphonic audio material.

® Polyphonic Decay is a variation of this algorithm that is particularly suitable for highly
percussive signals within which, however, a tonality is discernible.

Please note that DNA is designed for tracks containing a single polyphonic instrument (a guitar, a
piano, ...) and that it divides the material up according to pitch — not instrument. If two instruments
play the same note at the same time, what is available for editing is a single note comprising the
combined sound of both instruments.
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NB: There is some audio material that cannot be detected using the polyphonic algorithms because it
contains too few tonal components. If in the case of such material you have chosen one of the
polyphonic algorithms as the default (see below), the polyphonic detection process will be interrupted
and a fresh detection of the material using the Percussive Algorithm, which is better suited to it, will
commence. If you wish in such cases, when this detection is complete, you can still switch to
Universal or Melodic.

The Universal algorithm

The Universal algorithm is particularly suitable for complex signals containing both percussive and
tonal elements. If, for example, you wish to alter the pitch, timing or tempo of an entire piece of music,
this algorithm will deliver the best sound quality.

The Universal algorithm, like the Percussive one, displays all the detected notes at the same pitch.
The Pitch Ruler displays no note names, merely relative values for the semitones, and the scale
functions are deactivated. The Universal algorithm completes the detection process very quickly and
also consumes far fewer resources than the Polyphonic algorithm. It represents a good choice,
therefore for recordings of individual instruments of all kinds that you intend simply to speed up, slow
down or transpose. Tracks, in other words, for which you do not need bells and whistles such as DNA
or Melodyne’s scale functions. Please note that with files that have been detected using the Universal
Algorithm, the Attack Speed Tool cannot be used. Attack speed handles will therefore not be

© Celemony Software GmbH 2021 « Last updated on 03/23/2021 « Help Center « www.celemony.com 33



http://helpcenter.celemony.com/hc-2/?lang=en&startPageEdition=melodyne-editor
http://www.celemony.com

Melodyne 4 editor - DAW without ARA

displayed for the corresponding blobs and the Attack Speed field in the Note Inspector will be grayed
out.
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Switching algorithms

You can at any time select a different algorithm to that chosen automatically for you by Melodyne.
You might want to do this, for example, if you find that the material has not been interpreted in a way
that suits your editing needs. To do this, while playback is halted, select the algorithm you prefer from
the Algorithm menu. Melodyne will reinterpret the material in the light of your choice and adjust the
display accordingly.

Note: when you do this, any editing performed prior to switching algorithms, including any copying of
notes, will be lost . The right time to decide which algorithm you wish to use, therefore, is before you
begin editing.

In the plug-in implementation of Melodyne, the choice of algorithm applies to an entire transfer, in the
stand-alone implementation, to an entire audio file in the document being edited — collectively, we
describe all such material as ‘audio sources’. Before you can change the algorithm applied to a
particular audio source, you must first select one or more notes belonging exclusively to it. If you have
selected no notes, or notes from two different audio sources, the Algorithm menu will be grayed out.
In such cases, reduce your selection to notes belonging to one audio source only and it will be
possible to switch algorithms.

When you switch algorithms, triggering a fresh detection, Melodyne looks at the status of the Auto
Stretch switch: if the Auto Stretch function is activated, once the new detection is complete, the tempo
of the file will also be adjusted: if Auto Stretch is not selected, the original tempo of the file will be
retained.

Automatic or manual algorithm selection

Melodyne by default selects the most suitable algorithm automatically, basing its choice on the
characteristics of the audio material. If, however, in an instance of the plug-in implementation of

© Celemony Software GmbH 2021 « Last updated on 03/23/2021 « Help Center « www.celemony.com 34



http://helpcenter.celemony.com/hc-2/?lang=en&startPageEdition=melodyne-editor
http://www.celemony.com

Melodyne 4 editor - DAW without ARA

Melodyne or in the current document of the stand-alone implementation material has already been
detected, when new material is transferred to that instance or a new file dragged into the stand-alone
implementation, Melodyne will use the same algorithm for the new material as it used for the old —
even if Automatic is selected.

Overruling the Automatic setting in this way is designed to ensure maximum consistency in the
detection and avoid all risk of one of the transfers from a vocal track suddenly being interpreted as
percussive. If, however, you have altered the algorithm of a transfer or file manually, the automation
kicks in again afterwards, and no further attention is paid in the case of further transfers or files to
already detected material.

This rule only applies when Automatic is selected as the algorithm. It does not apply, however, when
you are using Melodyne with ARA; nor when, in the stand-alone implementation of Melodyne, a new
file for which an MDD file already exists, containing the editing applied to its detection, is dragged into
a document

By setting a different default via the Algorithm menu, you can prevent Melodyne selecting an
algorithm automatically for the detection. This can be useful if, for example, you regularly want to edit
particular files using the Percussive algorithm but Melodyne, each time they are opened, is
interpreting the material as polyphonic. By preselecting the Percussive algorithm in such cases you
can save time, as you will no longer have to wait needlessly as Melodyne performs its polyphonic
analysis, only to discard the results moments later when you manually select the Percussive
algorithm.

t Options Help
™ Universal r
Percussive 3 &
v Melodic s
—

Polyphonic Sustain
Polyphonic Decay L

1 Automatic
k

Universal
Percussive
Melodic
Polyphonic Sustain
Polyphonic Decay

Do not forget, however, when you no longer need to impose your choice of algorithm on Melodyne, to
restore Automatic as the default setting. Otherwise, since Melodyne remembers your default selection
even after you have quit the program, you might be surprised to discover when the program is next
launched that your vocals have been interpreted as percussive.

© Celemony Software GmbH 2021 « Last updated on 03/23/2021 « Help Center « www.celemony.com 35



http://helpcenter.celemony.com/hc-2/?lang=en&startPageEdition=melodyne-editor
http://www.celemony.com

Melodyne 4 editor - DAW without ARA

Since Melodyne invariably conducts an analysis (we call it “detection”) of the audio material before
you can do any editing, the correctness or otherwise of this analysis has a considerable influence
upon how well you are able subsequently to work with the material and how good the results of your
editing sound. For this reason it is important to check whether Melodyne has detected the notes
within your material accurately and if necessary correct any mistakes. This where Melodyne’s Note
Assignment Mode comes in.

What editing the detection involves

When you are working in Note Assignment Mode, none of the changes you make has any audible
effect on the notes themselves. All you are doing is ensuring that the notes that are displayed do
actually correspond to those that were played or sung. In other words, you are bringing what you see
into line with what you hear. In the process, you are working at all times on the display of the original
recording and, with it, so to speak, on the basis for all musical changes made later with Melodyne.
The sounder the basis, the better the eventual sound of your edits.

The fact that it is sensible and necessary to check and edit the detection and, with it, the
interpretation of the audio material may seem tiresome at first sight. But it brings with it enormous
advantages, for there are often several possible interpretations of the audio material, and which is the
correct one in a given acoustic and musical context is for you, ultimately, to decide.

But don’t worry, the detection process in Melodyne is mainly automatic and the end result coherent.
How much there is to edit in this mode depends upon the algorithm used and the audio material in
question. With a dry recording of a single vocalist, for example, you will very rarely encounter
problems. It may happen from time to time that a note is detected in the wrong octave, in which case,
if you later transpose it, it will sound unnatural. Correcting the detection in such cases is a task swiftly
accomplished. The same goes for percussive material, where it is generally only necessary to
introduce or remove the occasional note separation.

It is the detection of polyphonic material, naturally, that requires the most editing. Here the issues are
more complex and more interpretations are possible than with the other algorithms, though, once
again, the amount of editing required is mainly dependent upon the nature of the audio material.
Thanks to their clear overtone structure, notes played on a xylophone, for example, are far easier to
detect accurately than any found on a distorted guitar track. This is because in the latter case the
array of overtones is more complex and assigning them to the correct notes more difficult. With such
and similar signals it might happen, for example, that a particularly prominent overtone is interpreted
as a separate note rather than as a component of another note (known as the “fundamental”) lower
down. If this mistake is not corrected and you later shift the pitch of the overtone on its own, leaving
the fundamental unchanged, the two components will clash and consequently sound unnatural.
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The overtone example illustrates it clearly: In many cases, Melodyne cannot be sure of its decision,
as it cannot know which notes were actually intended and played. In Note Assignment Mode,
therefore, the object is to ensure that the notes displayed correspond to those that were actually
played and intended. The advantage comes when you begin editing: a Note Editor that displays only
the correct notes and the best possible sounding results.

What is edited and where

Like the choice of algorithm, Note Assignment Mode applies invariably to all the notes of i) a
particular audio file, ii) a particular recording, or iii) a particular transferred segment — we will use the
term “audio source” to cover all three. When the Note Editor contains notes from different audio
sources, begin by selecting a note belonging to the source the detection of which you plan to edit.

=P LEL I
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Now click the wrench (spanner) icon next to the toolbox of the Note Editor to activate Note
Assignment Mode. The background in the Note Editor changes color to show that you are no longer
in normal Edit mode but have switched to Note Assignment Mode. In Note Assignment Mode, what
you see and hear is the original state of the audio source; any editing you may have performed on it
previously is ignored here.

Any time you click on the blob icon (to the left of the wrench), you will leave Note Assignment Mode
and return to edit mode. There you will hear once again the results of any editing you performed
before switching to Note Assignment Mode. This only applies, however, if you have not changed
algorithm in Note Assignment Mode, as any change of algorithm triggers a fresh analysis, and any
time you trigger a fresh analysis — any time, in other words, the detection process is repeated — all
editing that has been performed on the notes previously is lost.

The Algorithm Inspector

Whenever Note Assignment Mode is active, the Algorithm Inspector is available in the info pane.
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Algorithm: The pop-up button at the top shows the current algorithm. With the menu displayed, you

can select a different algorithm from the list, thereby triggering a fresh analysis. Warning: Any time
you switch algorithms, all editing previously performed on the audio source in question is lost! For this
reason, you should make a habit of checking to make sure the best algorithm has been selected and,
if this is not the case, choosing a more suitable one before you begin correcting the analysis or
editing notes.

Tip: In the stand-alone implementation of Melodyne, it is possible, prior to switching algorithms, to
save the assignment file of the audio source (see below) and, if not satisfied with the new algorithm,
reload it. In this case, the previous algorithm — and, with it, all your previous editing of the detection —
will be restored; but only of the detection; any normal editing of the notes you may have performed in
edit mode will, even in this case, be lost. This is an inevitable consequence of switching algorithms.

In the preview section, you will find the following important options to assist you with the editing of the
detection and the fine-tuning of the algorithm parameters.

Preview
Synth: | A, Off
Tempo: 100 %
Pitch: Oct
Formants: Oct

Synth: The objective in Note Assignment Mode is to ensure that the notes displayed really do match
the notes intended and played. Since, however, in Note Assignment Mode you are listening to the full
original sound of the audio file you plan to edit and editing of the blobs has no audible effect,
determining whether notes have been correctly detected is generally only possible on a visual basis.
This is where the Monitoring Synth comes in: Using a synthetic tone generator, the Monitoring Synth
plays the blobs exactly as they appear, thereby providing you with acoustic as well as visual
feedback. You can toggle the synth on and off by clicking on the “Z” icon; click and drag upwards or
downwards to control the volume.

The Monitoring Synth is not available when the Percussive or Universal algorithms are selected.

Tempo, Pitch and Formants: With these three controls, you can “simulate” changes to the
corresponding parameters in order to examine their effect upon the current algorithm settings.
Example: you have changed the formant character in the Algorithm Inspector. This change, however,
has no effect until you shift the formants in normal edit mode, as in Note Assignment Mode you
always hear the original state of the audio source. You would have, therefore, to leave Note
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Assignment Mode, shift the formants by way of experiment in normal edit mode, and then return to
Note Assignment Mode if you felt any further adjustment to the formant character was necessary. The
preview controls make such a procedure unnecessary: simply turn the formant control, and you can
begin at once experimenting with the character slider without ever leaving Note Assignment Mode.
The tempo and pitch controls operate much the same way. The values of all three preview controls
only apply temporarily and are reset each time you leave Note Assignment Mode.

NB: When the synth is in use, the controls for pitch and formants are grayed out, as they cannot be
used simultaneously.

The other parameters in the Algorithm Inspector relate to the behavior of the algorithm, allowing you
to fine-tune it for the entire audio source.

T
Algorithm | Note @ Project | File

Universal s

Playback Type: Complex
Character: Smooth ¢

“w

Transients:

Formant Correction
Up:
Down:
F. Character:

Playback Type: Melodyne applies two different processes for the playback of audio. The Melodic
Algorithm employs as standard the playback type “Tonal”, whilst the other algorithms favor
“Complex”. These choices are generally the best in practice but you can override them here if you
wish.

The difference is most noticeable when time stretching is performed (and also when notes are
transposed upwards): material with clearly recognisable pitches generally sounds better with the
“Tonal” option. For material in which the pitch of notes is not clear and where noise components are
more in evidence better results are generally obtained with “Complex”. Experimenting with the two
playback types is therefore most useful when material falls between these two stools. Experiment with
the tempo and pitch preview controls to see which playback type is best suited to your needs. Please
note, however, that if “Tonal” is selected, the Character, Transients and Formant Character
parameters described below are no longer available and therefore grayed out.

Tip: For the playback type “Tonal”, a variation called “Tonal (high)” is also available. If you are
working with sopranos or very high-pitched melodic instruments (such as piccolos), instead of “Tonal”,
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you should try out the variant “Tonal (high)”, as this could enhance the sound quality. Voices or
instruments with normal registers, however, are less well served by “Tonal (high)”, so its use in such
cases is best avoided.

Character: This is a another pop-up button and allows you to select between a smoother and a
crisper playback. If “Crisp” is selected, Melodyne uses a smaller processing window that allows fast
acoustic movements in the signal to be reproduced more clearly. This setting is therefore best for
percussive sounds and others with many fast tone changes. To soft, sustained sounds, however, the
crisper setting can introduce a certain restlessness. To avoid this, opt for “Smooth” which employs a
larger processing window and is therefore more suitable for the reproduction of smoother, more
gradual tonal transitions.

Transients: This parameter is only available when the Universal and Percussive algorithms are in
use. It determines how the transients in the signal should be handled during playback. With the slider
fully to the right (the default position in the case of the Percussive algorithm), the transients are
clearer and more acute. As the slider is moved to the left, the transients become softer. By default,
with the Universal algorithm selected, the slider is in the middle. Experiment to see which setting
delivers the best sound with your own material.

Formant Correction Up/Down: Whenever you transpose a note in Melodyne, the formants are
automatically corrected to avoid, in the case of vocals, the dreaded “Mickey Mouse” effect. Or, in
technical terms, whenever you transpose a note a whole tone upwards, Melodyne automatically
corrects the resulting formants by shifting them back down a tone, in this way preserving the original
timbre. In the case of the human voice, this is generally what is wanted, but with an acoustic guitar
perhaps not: With many sounds, it can add charm if the formants are transposed in parallel with the
fundamentals — i.e. not automatically corrected.

The Formants Up and Down sliders are provided, therefore, to allow you to determine the degree of
the automatic formant correction — independently for upward and downward transpositions. With the
slider all the way to the right, the full 1200% formant correction is applied; fully to the left, no automatic
formant correction at all is applied. When you return to normal edit mode, you will only hear the effect
of these parameters if you shift, or have shifted, the formants of one or more notes in the Note Editor.
To simulate and test their effect in Note Assignment Mode, use the pitch controller in the preview
section of the Algorithm Inspector. If the current value for this is positive, you will be able to preview
the effect of the Up slider; if the current value is negative, you will hear the effect of the Down slider.

F(ormant) Character: When formants are shifted, this slider alters their weighting in the frequency
range and therefore alters the sound of the shifted formants. Experiment to see with which setting
your material is best reproduced. This parameter has no audible effect when you return to normal edit
mode unless and until notes have been transposed in the Note Editor. To simulate and test its effect
in Note Assignment Mode, use the formant control in the preview section of the Algorithm Inspector.
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Separate Audio
Auto Now

Separate Audio: When you are editing the detection of an audio source, Melodyne sometimes has a
great deal of processing to perform in the background and large volumes of data to move in and out
of its cache. The option Separate Audio gives you control over this behavior. If the Auto box is
checked, with each change you make, Melodyne performs all the requisite calculations immediately.
The advantage? Whenever you use the preview controls to test your algorithm settings, Melodyne
accesses the latest data, and everything sounds exactly as it would in normal edit mode. The
disadvantage? Melodyne sometimes needs to introduce a processing pause during which the
progress indicator appears and your work is interrupted.

Since you do not always need the preview controls, you have the option of changing this behavior by
clearing the Auto checkbox. The various calculations will then no longer be performed immediately
but only when you click the Now button or leave Note Assignment Mode. The advantage of this is that
your workflow is not interrupted. The disadvantage is that the preview controls in this case do not
always reflect the changes you have made. When there is a discrepancy between the previous data
and the current state, the Now button flashes to warn you. If you click it, Melodyne will perform all the
outstanding calculations and update the totality of the data.

Assignment File Load/Save (stand-alone implementation only): Melodyne can, if you wish, save
your audio source as an assignment file containing such information as which algorithm was used for
the source, the status of the algorithm parameters, and what editing was applied to the detection. The
advantage of this is that it means the detection process does not have to be repeated each time the
file is opened in Melodyne; furthermore, it means you only need to edit the detection and set the
algorithm parameters once, as your work and settings will be restored automatically when the file is
reopened. With the Save button, you can store such an assignment file alongside the edited audio
file; the Load button allows you to reopen the file, in order, for instance, to revert to the original state
after an inadvertent change of algorithm.

The Main Tool in Note Assignment Mode

In Note Assignment Mode, the toolbox contains tools with functions other than those used in normal
Edit mode. The most important difference is this: In Note Assignment Mode, the tools have no direct
or immediate impact on the sound of the notes; their object, rather, is to bring the detected and
displayed notes as closely as possible into line with the actual music. This makes it possible
subsequently to edit the material more efficiently and obtain optimal acoustic results.

Which tools are available depends upon the algorithm, as, to a lesser extent, do their functions.
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The Main Tool in Note Assignment Mode combines important functions of the other tools, as it does in
normal editing mode, so that you can perform a variety of common tasks without changing tools.

SR N b o
A 7 18

® In the lower part of a blob, the Main Tool functions as the Activation Tool.
® In the upper part of a blob, the Main Tool functions as the Note Separation Tool.

We will deal with each of these in turn.

The Activation Tool

The Activation Tool has no function when the Percussive and Universal algorithms are selected.

If you click on a note with the Activation Tool, its overtone series is shown in the editing background.
This enables you to recognize at a glance the octaves and other harmonic ratios of the displayed
notes.

The Melodic Algorithm: Double-clicking on a blob instructs Melodyne to remove the note in question
to the next most plausible pitch, if there is one. Particularly plausible alternative pitches are denoted
by hollow blobs — so-called “potential notes” — and tend to lie an octave above or below the original
blob. You can also double-click directly on one of these potential notes in order to activate it and
deactivate the original blob. If Melodyne is unable to find a plausible alternative to the blob you have
double-clicked, it leaves it where it is.
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Dragging the blobs vertically with this tool has much the same effect: It instructs Melodyne to search
higher up or further down for an alternative pitch. If a plausible pitch is found in the direction indicated,
the blob snaps to it; otherwise it returns to its original position. You will use these double-clicking or
dragging techniques to correct occasional octave errors in the detection. The Polyphonic Sustain
and Polyphonic Decay algorithms: With the polyphonic algorithms, potential notes play a
particularly important role. It can happen, for example, that a note has an overtone so prominent that
this is taken for a separate note and assigned a blob of its own. In extreme cases, it can happen that
a solid blob is awarded only to the overtone in question and denied to the fundamental itself; here,
since the fundamental has been reduced to the status of potential note, it is represented by a hollow
blob.

If you double-click on a solid blob with the Activation Tool, you deactivate the corresponding note.
The spectral energy that Melodyne had attributed to this note will then automatically be redistributed
among the other notes sounding at the time. An overtone wrongly granted the status of fundamental
would, when deactivated, be reassigned to its fundamental. If you double-click on a potential note, it
will be activated. Spectral energy in this case will be “confiscated” from the other notes sounding at
the time and given to the newly activated note.

Dragging blobs upwards or downwards has much the same effect as with the Melodic algorithm.
Melodyne searches in the corresponding direction to see whether a fundamental might plausibly be
located there. In all probability, if a pitch is found that could reasonably be that of the fundamental, a
potential note will already have been detected there; this will then be activated and the previous note
deactivated.
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The slider and the Energy Image

When you are editing the detection of polyphonic audio material and have selected the Main or
Activation tools, you will see a slider next to the toolbox. This allows you to determine the number of
potential notes to be displayed and how many actual notes are derived from them.
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If you move the right-hand indicator (the “Parenthesis”) in the slider to the left, fewer potential notes
will be displayed. If you drag it to the right, more potential notes will appear. Choose a setting that
ensures that only as many potential notes are displayed as you may conceivably wish to activate in
the course of the subsequent editing. That will give you a clearer overview.

Now drag the left-hand indicator (the “Ball”) from side to side. As you drag it to the left, you reduce the
probability of the potential notes displayed becoming active notes, thereby reducing the number of
active notes. As you drag it to the right, you increase that probability, thereby creating more active
notes from the potential notes displayed.
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There can never be more active than potential notes, so the Ball can never pass through the
Parenthesis but merely pushes it to the right when it wants to go further, thereby causing additional
potential notes to be displayed and activated simultaneously. Adjust the two indicators until the
number of active notes displayed is as close as you can get to the number of notes that were actually
played. Then proceed to the manual correction of individual notes.

Tip: If you move the indicator a long way, Melodyne is required to do a great deal of processing,
which is why it can take a moment to display the results. You can reduce this delay by checking the
option Update Audio Signal Immediately in the View menu’s Note Editor Options sub-menu — at the
cost, of course, of a temporary increase in the CPU load.

Now and then, it can happen that a note that can be heard in the material is not detected as an active
note, and, even with the Parenthesis at its maximum setting, is not even shown as a potential note. If
that happens, move the Parenthesis fully to the right (to its maximum setting) and then move the
mouse pointer over the position in the Note Editor where the missing note ought to be. Around the
mouse pointer, in the form of an “energy image”, notes will now appear that were detected neither as
active nor as potential notes. When you have identified the missing note in this way, double-click on it
to transform it into an active note. Thereafter, by subsequent double-clicking, you can toggle the
status of these notes between “potential” and “active” just like that of any others.
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The Venetian Blinds

With instruments in particular that generate powerful overtones, it can happen that over a wide range
notes are detected that you perfectly well know are far higher (or lower) than any that were actually
played. In such cases, the Venetian Blinds come in handy; if you can’t see them at the top or bottom
of the editing area, scroll upwards or downwards until you can.
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You can raise or lower the top blind by dragging its thick bottom edge and do the same with the top
edge of the bottom blind, in this way delimiting the range within which Melodyne assigns notes. All
notes partially concealed by the Venetian Blinds are automatically deactivated unless they have
previously been activated by hand. You can still “reach through” the Venetian Blinds, however, to turn
notes on or off. The Venetian Blinds provide a useful first approximation that you can later correct by
activating and deactivating notes singly by hand.

Starting point lines and designated starting points

If, in Note Assignment Mode, you select one of the separation tools, vertical lines appear in the Note
Editor. At the same time, a slider with two indicators appears next to the toolbox.

We call the vertical lines “starting point lines”. Rising in parallel from their respective blobs to the Time
Ruler, they show the musical starting points that Melodyne has identified in the audio file. A
“designated starting point” is indicated by a short vertical line (a “vertical”) topped by an inverted
triangle and is invariably found near the start of a blob (though not necessarily at its leftmost
extremity); when active, it indicates what, for the purposes of timing, Melodyne considers to be the
effective musical starting point of the note. The musical starting point may, but does not necessarily
have to, be aligned with the separator at the beginning of the note. Think of a brass instrument, for
example, where each note is often heralded by a certain amount of wind noise. This noise also
belongs to the note, so it falls to the right of the note separator. What is relevant from the standpoint
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of timing, however — as is the case also with quantization — is the moment when the sound really
unfolds and the pitch first becomes discernible; that is the timing-critical moment, and it is that later
instant that is designated the musical starting point. If Melodyne is unable to pinpoint the musical
starting point of a note, no starting point line is displayed and the note has no designated starting
point. For the purposes of quantization, the leftmost extremity of the note is then considered to be the
starting point.

Each of the longer, starting point lines also culminates in an inverted triangular indicator, which you
will see just below the Time Ruler. This indicator can be solid, in which case the corresponding
starting point line is visible and active; or it can be hollow, in which case the line is invisible: we call it
in this case a “potential” or “inactive” starting point line. An inactive starting point line invariably
coincides with the beginning of a note. For the note in question, however, Melodyne has been unable
to discern with sufficient confidence a musically relevant starting point; it is for this reason that the
starting point line is only a potential one and that no vertical (no designated starting point indicator) is
displayed at the blob.

The two slider indicators, the Parenthesis and the Ball, govern, respectively, how sensitive Melodyne
is to the presence of potential starting points and how willing it is to activate them, the result being
reflected in turn by the total number of triangles displayed and the percentage of these that are solid
red. As you move the Parenthesis gradually to the right, more and more hollow triangles (indicating
the presence of “potential” starting points) appear beneath the Time Ruler; this reflects Melodyne’s
increasing sensitivity that is allowing it to divine more and more points in the material at which a
starting point might reside — “might” because the lines that are added remain invisible and do not (yet)
have any effect upon the blobs.
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You can alter this, however, with the slider's second indicator: the Ball. As you move the Ball to the
right, more and more of the previously invisible, “potential” starting point lines will become active; and
directly below them, at the level of the blobs, designated starting points will appear at the same time.

You can activate a potential starting point line by double-clicking on the hollow triangular indicator
beneath the Time Ruler and, conversely, deactivate an active line by double-clicking on the
corresponding solid triangle. Double-clicking in a free place in the ruler generates a new starting point
line.

By dragging its indicator, it is possible to move a starting point line forwards or backwards in time;
this, however, will seldom be necessary, as Melodyne almost invariably identifies the ideal position.
You may still wish, though, to do some fine-tuning. If, for the purposes of experiment, you move a
starting point line from left to right, you will notice that as soon as you pass over the start of a blob, a
vertical appears complete with inverted triangle (indicating the presence of a designated starting
point) that follows the line for a while before disappearing as soon as the note begins to decay, as,
clearly, it would be futile to look any further for the musical starting point.

|1 2
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Starting point lines exhibit a kind of “magnetic” property seen not only when you move them but also
when separating notes and designating starting points manually.
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The Note Separation Tool and the Separation Type Tool

The Note Separation Tool and the Separation Type Tool (directly below it in the toolbar) are available
with all algorithms and function in the same way as their counterparts in Edit Mode. You can set or
remove note separations by double-clicking and also move them along the time axis. With the
Separation Type Tool, you can toggle between hard and soft separations.
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By contrast with normal editing mode: In Note Assignment Mode, the separation tools are not used to
reshape the music but to edit the analysis or “detection”. The object is to ensure that the blobs
represent as accurately as possible the actual music. Also, edits performed in Note Assignment Mode
on chords are implemented, thanks to the magnetic quality of the starting point line, with sample
accuracy. In normal Edit mode, this is not possible. Tip: To provide two or more notes of differing
pitch with a soft separation, you can select “Convert Selection to Connected Sequence” from the
context menu (see below).

Since the placing of note separations and the editing of starting points often go hand in hand, you can
also edit starting points with the Note Separation Tool. Simply move the pointer into the vicinity of the
triangular starting point markers near the Time Ruler and it changes appearance to resemble the
Starting Point Tool.

It is possible at any time to deactivate a designated starting point (i.e. withdraw the designation). A
new starting point can only be designated if an active starting point line is present in a plausible place
i.e. the left-hand end of a blob. Look for a moment at the starting point indicators: In the relevant
place, a hollow triangle (indicating the presence of a potential starting point) will probably already be
displayed. Double-click on the triangle to activate the starting point line.

If no potential starting point line has been identified at the desired position, using the slider near the
toolbox you can cause additional potential starting point lines to appear: to do this, simply move the
right-hand control element (the Parenthesis) further to the right.
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Alternatively, by double-clicking on an empty area of the ruler at the level of the starting point
markers, you can create a new starting point line and drag it into position with the mouse. If, in the
case of polyphonic material, a chord appears at the corresponding position, the action will affect all
chord members. When, with the Melodic, Percussive or Universal algorithms selected, you activate a
potential starting point line or create a new starting point line, a note separation is automatically
inserted near a note at the position in question.

Tip: When editing starting point lines, if ever you have the feeling that somewhere a note starting
point exists but that it is not indicated even by a potential starting point line, scrubbing in the relevant
area often makes it to easier to locate the exact position. At the position in question, a rather loud
noise component will be audible. Where the noise is loudest, release the mouse button and double-
click to place a starting point line.

The context menu: When you select one of the note separation tools, a context menu appears in the
Note Editor in which you will find the following commands:

® Convert Selection to Connected Sequence: With this command, you can convert a selection
comprising two or more adjacent notes between which there are hard separations into a
connected sequence with soft separations. This is also possible with notes differing in pitch
and allows you gather together melodic lines to make more coherent editing possible later.

® Separate Note: This command separates notes automatically at a point determined by
Melodyne. It is useful when you need to make precise cuts in a vocal passage and isolate
sibilants or breathing noise prior to editing using the tools.

® Reseparate Notes at Starting Point Lines: This command splits the selected notes at all active
starting point lines passing through them. It offers you, therefore, a convenient way of inserting
separations at the same point in multiple notes simultaneously, while removing any
superfluous separations found elsewhere.

® Separate Notes as Trill: The effect of this command is to slice a selection of one or more notes
into smaller segments determined by the instantaneous pitch of each note. This is done by
inserting note separations into the slopes of the pitch curve as it rises and falls, thereby turning
each ‘hill’ and each ‘valley’ of a vibrato into a separate note.

Please note that the fluctuations in the Pitch Curve must be fairly pronounced for the “Separate Notes
as Trill” function to have any effect and that it is only available when the Melodic algorithm is active,
being grayed out in every other case. If you wish to assign a shortcut to the command “Separate
Notes as Trill", this can be done using the Preferences dialog.

® Reset Separations Based on the Selected Grid: This command separates the notes at obvious
starting points as well as at suitable positions on the selected Time Grid. This command is
available with the Melodic, Percussive and Universal
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algorithms.

The Starting Point Tool

The Starting Point Tool is the second sub-tool of the Note Separation Tool.

It is available with all algorithms and is used to designate or undesignate starting points manually by
double-clicking. This tool function is also available in Note Assignment Mode by checking the
corresponding option in the Note Inspector. A designated starting point is indicated by a vertical (i.e. a
short vertical line) with a red triangle on top located at or near the leftmost extremity of the blob.

By moving the Starting Point Tool in the region of the starting point markers beneath the Time Ruler,
you can also edit these with the Starting Point Tool. As a rule, however, you will generally use the
Note Separation Tool for this purpose, as described above.

The Energy Share Tool

This tool is only available with the Polyphonic Sustain and Polyphonic Decay algorithms. It regulates
the distribution of particular sound components among notes sounding simultaneously.

In the case of chords or certain harmonic intervals (e.g. an octave), the same overtone might be
shared by two or more fundamentals, so Melodyne is obliged to share it out among the notes
concerned. It may be that the resulting distribution is not to your liking, in which case you can exert a
healing influence: By assigning more energy to one fundamental (at the expense of the others), you
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enrich its harmonic content, giving it, generally, a brighter sound with greater penetration. Conversely,
you can deprive a fundamental of some of its energy (to the profit of the others). In this way, you can
adjust the tone color of the various notes to achieve the ideal balance.

Please note that this tool, by its very nature, only has any effect when two or more notes sounding
simultaneously have been detected in polyphonic material and one of them is being edited.
Furthermore, only as much energy can be shared as is actually present at the position in question
and available to the blob in question. With this tool, you are therefore to some extent entering a
desired value. How and to what extent it can be attained depends upon the realities of the audio
material.

In the extreme case, the tool does ... nothing. If you have two notes sounding simultaneously, for
example, the higher of which does not appear in the overtone series of the lower (you can see
whether or not this is the case by using the Activation Tool to display the overtone series), then these
two notes have no shared energy that could be reassigned using the Energy Assignment Tool. In
such cases, therefore, the tool has no effect whether visual or acoustic.

Click with this tool on a blob and drag upwards to increase its allocation of energy or downwards to
reduce it.

The Note Inspector

As is the case in normal edit mode, the Note Inspector in Note Assignment Mode governs the
selected notes — only here, different parameters are on view.

Algorithm | Note | Project | File

Pitch: c4
+2 ct

262.0 Hz

Energy Share: 1.00

Hard separation:
Starting point: |V
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Pitch: The three fields correspond to those in edit mode and display i) the nearest note of the
chromatic scale, ii) the deviation (if any) in cents from it, and iii) the equivalent frequency in hertz. It is
not possible to input values into these fields but their content is updated whenever a blob is assigned
to a different pitch (e.g. to correct an octave error). Energy share: The inspector field reflects the
changes made with the Energy Share Tool as well as allowing you to enter values directly. Hard
separation: The status of this field is determined either by changes made with the Separation Type
Tool or by checking/clearing the box. You can only check this box if there is currently a soft
separation between the selected note and an adjacent one.

Starting Point: The status of this field is determined either by changes made with the Starting Point
Tool or by checking/clearing the box. Here, just as with the corresponding tool, you can attach the
selected note to a starting point line or detach it from it.

© Celemony Software GmbH 2021 « Last updated on 03/23/2021 « Help Center « www.celemony.com 53



http://helpcenter.celemony.com/hc-2/?lang=en&startPageEdition=melodyne-editor
http://www.celemony.com

Melodyne 4 editor - DAW without ARA

The Time Grid slices up the time axis at regular intervals to provide a clearer temporal overview. It
can also have the function, however, of causing content as it is moved to snap to the nearest grid
line, thereby making it easier to position notes exactly on the beat. For the spacing of the grid (i.e. the
distance between adjacent grid lines), you can choose between Seconds and any of a variety of note
values (half note, quarter note etc.).

Activating and setting the Time Grid

To adjust the Time Grid, either choose Options > Time Grid from the main menu or click the note icon
(at the top right of the Note Editor) to open the pop-up menu shown here.

Clicking on the note icon activates or deactivates the grid; you can also define a keyboard shortcut for
this command from the Shortcuts page of the Preferences dialog. If you click the note value or the
arrow alongside it and hold down the mouse button, the grid menu pops up.

This allows you to the set the interval between grid lines to any of a variety of regular or triplet note
values or else to Seconds.
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The time axis is then graduated at intervals equivalent to the note value selected. If you have chosen
a small note value (such as 1/16) and then zoom the display outwards, at a certain point it will
become impossible to display all the grid lines; the grid value selected, however, will remain active.

%41 %42

Moving notes when the grid is active

When the Time Grid is active and Seconds is not checked, notes moved from one beat to another will
end up the same distance from the new beat as they were from the old one. In other words, whilst the
grid does influence their position, they don’t snap exactly to the nearest grid line unless they were on
a grid line to begin with. The note depicted below, for example, sounds slightly after the first beat of
the bar.

A A
If, while the grid is active, this is moved to the second beat, there, too, it will sound slightly after the
beat — the offset in the two cases being identical.

Even if the grid is active, you can still adjust the position of a note (or a selection of notes)
independently of the grid by holding down the [Alt] key as you move it.
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You can shift the pitch of notes in Melodyne either continuously or in discrete steps using the grid.
When the grid is active, notes can only be moved to such pitches as the grid allows. The grid in such
cases can correspond to either the chromatic or some other scale.

The functions of the Pitch Ruler and access to the Pitch Grid

Melodyne offers you a wide choice of scales and a comprehensive set of functions for the editing and
creation of scales that even extends to the ability using the Scale Detective to detect the scale used
in one recording and apply it to another.

All these functions and options are reached via the Pitch Ruler to the left of the Note Editor. They are
organized in such a way that you only ever see the parameters you actually need for the task in hand.
Think of a drawer that can either be pulled slightly open or else opened to its maximum extent. In this
tour, we are concerned with the selection and use of scales, so we will pull the drawer only a third of
the way out.

You can change the options relating to the Pitch Grid either from the sub-menu of the same name
under Options in the main menu or by clicking the clef icon directly above the Pitch Ruler.

,
6\ : = A‘I ‘ 2 3
No Snap
Chromatic Snap

v Scale Snap

Piano Keyboard
+ Scale Notes
Pitch Lines

+ Note Names
Degree Names
B ]

Activating the Pitch Grid and selecting display options

Single-clicking the clef icon activates or deactivates the Pitch Grid, thereby switching on and off the
snap function. When the grid is inactive, you can move notes freely in pitch — even to frequencies
falling between notes of the chromatic scale. The Pitch Ruler in this case displays, for reference only,
faint lines between the notes.

If you click the clef icon or the small arrow symbol alongside it, hold down the mouse button and drag
downwards, a drop-down menu opens displaying the snap, background and ruler options:
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Shap

® No Snap: The grid is inactive. Notes can be moved to any pitch, whether or not it coincides
with a degree of the chromatic scale.

® Chromatic Snap: Notes snap to the nearest degree of the chromatic scale and the lines on the
Pitch Ruler are more boldly displayed.

® Scale Snap: In this case, based on its own analysis of the audio material, Melodyne selects
what it considers the most appropriate major or minor scale. The tonic (or ‘keynote’) thus
ascertained is highlighted in the Pitch Ruler. Naturally you can alter the scale and tonic but we
will come to that in a moment. Let’s look first at the other options in this menu.

Background
Here you can choose the appearance of the background in the Note Editor.

® Piano Keyboard: the darker beams in the Note Editor represent the black notes of a piano
keyboard and the paler beams the white ones — a layout with which users of most MIDI editors
will be familiar.

® Scale Notes: The lighter beams are assigned to the notes of the scale, whilst the darker
beams indicate notes foreign to it. When Scale Snap is selected, therefore, notes will
invariably come to rest on the lighter beams.

® Pitch Lines: The degrees of the scale are indicated by bold lines instead of beams — with
thinner lines reserved for notes foreign to the scale. This is useful in the case of poor
intonation, as the precise pitch of each degree of the scale is clearly indicated.

Ruler
Here you can choose whether the Pitch Ruler displays the names of the notes or the degrees of the

scale.

The Scale Ruler and the Reference Pitch Ruler

To select a tonic (keynote) and a scale yourself or change other settings, open the drawer we
mentioned earlier a little wider by clicking the rightmost arrow beneath the Pitch Ruler. Two new
columns will appear to the left of it.
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Adjusting the master tuning

The narrow column on the very left is the Reference Pitch Ruler. Drag in either direction the mark
alongside any note — A4, for example — and the Frequency Ruler appears, which you can consult as
you fine-tune the note in question and, with it, of course, all the other notes of the scale. What you are
doing here is adjusting the master tuning for the entire Pitch Grid. A tip: increase the vertical zoom
factor, as this will make it easier for you to locate the value you want.

c I c5
8 500 B
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+12,0 4431 A
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400
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By right-clicking any of the marks on the ruler, you can open a small context menu. This offers a
number of pointers to help you bring the Pitch Grid swiftly into line with a particular tuning:
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At the top, you will see the current frequency of the note selected.
Concert: bases the tuning on modern standard concert pitch (where A4 = 440 Hz).

Default: bases the tuning on the frequency currently assigned to A4 in the Preferences dialog.

Detected: bases the tuning on Melodyne’s analysis of the music being edited — the original
tuning.

Set as Default: tells Melodyne to use the current value as the default tuning for new
documents and adjusts the value in the Preferences dialog accordingly.

The various settings for A4, incidentally, can be found quickly by clicking the tuning fork icon at the
top of the Reference Pitch Ruler. By typing into the box immediately below this icon, you can assign
to A4 any frequency you like.

—

—

440
iy S

C

Selecting the tonic and scale variety

The wider ruler next to the Reference Pitch Ruler is the Scale Ruler. Here you can select the ‘tonic’ (i.
e. the first degree or keynote) of the scale as well as its mode or type. First click on the note you wish
to use as the tonic. The following menu opens:
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Related scales: in the top part of the menu, you will find a varying number of scales preceded by a “="
sign. These are scales that correspond to the current scale but are differently named.

Please note that when you select a related scale from this menu, only the main structure of the mode
in question is adopted: the scale is simply given a new name and, if applicable, a new tonic. It can be,
however, that the exact definition of the related scale in question contains additional secondary
degrees or fine-tuning. If you wish to use these, please choose Open Scale... from the scale drop-
down menu.

® The current note: in the middle of the submenu, grayed out, you will see the name of the note
you have clicked on and which you can now make the tonic.

® Major / Minor: Allows you to select a major or minor scale with the note selected as tonic. To
select C Major, for example, click C in the ruler, followed by C Major from the submenu.

® Open Scale... : opens Melodyne’s Scale Window, which offers access to a wide variety of
additional scales. This window will be described in the next section.

® Analyzed: this offers you rapid access to two options derived from Melodyne’s analysis of the
material: the closest major or minor scales and an exact microtonal scale.

®* Notes Reflect Scale Changes: normally when you change the scale, Melodyne adjusts the
Pitch Grid but does not change the notes themselves unless you double-click on them first, in
which case they will snap to the grid. If, however, you wish the notes to adjust automatically to
any change of scale, select either Tuning or Tuning and Mode. Then any changes will take
effect immediately and you will hear them at once during playback.

® Play Scale: plays the current scale. When this function is active, the loudspeaker icon appears
above the Scale Ruler. By clicking on this icon, you can deactivate the function without
needing to access a menu. * Apply Dynamic Just Tuning: fine-tunes the selected notes
applying the principles of just intonation to ensure that pure intervals result.
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Dynamic just intonation: Dynamic just intonation eliminates the slight dissonances and resulting
interference (or ‘beating’) between notes that come with equal temperament. By this means a
smoother sound can be obtained, as is demonstrated, for instance, by real orchestras. We speak of
“dynamic” just intonation because not only are the intervals pure but the pitches are also shifted
minutely to ensure that the chord member most affected by the just intonation is as near in pitch as
possible to its counterpart in equal temperament. Example: Melodyne shifts a justly tuned chord of C
major (C + 0 ct, E — 13 ct, G +2 ct) six cents up, so that the E is not too far removed from its even
temperament counterpart. Furthermore, this fine-tuning of notes is not static but governed by the
current harmonic context. So in the time dimension, too, it is dynamic, to ensure that at each instant
optimal tuning is obtained.

Tip: Initialize the key prior to the transfer/load: In the case of monophonic or polyphonic audio
material, Melodyne also recognizes the key of the music. With short melodic phrases, however, the
key chosen is often not the one intended, simply because too few notes are available for a correct
appraisal. To prevent this happening, you can set the key using the Scale Ruler of an empty instance
of the plug-in or an empty document (if using the stand-alone implementation of the program) before
the transfer or loading of an audio file. To do this, simply click on the desired keynote in the Scale
Ruler and select the desired scale from the context menu. Melodyne will then retain this initialized
value, regardless of its own subsequent analysis.

The Scale Window

Melodyne’s Scale Window offers a multitude of scales you can select, listen to, and make use of. To
access this window, choose “Open Scale” from the context menu of the Scale Ruler.

The selected scale applies to all instances of the Melodyne plug-in.
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To open the Scale Window, select Open Scale from the context menu of the Scale Ruler.

Now choose a category from the left-hand pane followed by the desired scale from the pane on the
right. Click the loudspeaker icon to the right of each entry to hear the scale selected.

If you have activated the option Notes Follow Scale Changes, during playback you will hear
immediately the effect of applying the scale selected to your audio material. The window allows you to
try out (or ‘audition’) different scales quickly and easily. If you wish to adopt the changes, exit the
window with OK; otherwise click Cancel.

From the lower pane of the window, you can select between the parameters of your existing scale
and those of the scale selected in the Scale Window.

®* Mode and Tuning: you can adopt either the parameters of your existing scale (on the left) or of
the scale currently selected in the Scale Window (on the right).

® Tonic: you can choose between the selected tonic or the tonic from the preset.

® Pitch: here you can choose between current tuning, the pitch from the preset or various
standard tunings.
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® Stretching: here you can select whether or not stretched tuning should be applied to the scale.

® External Scales Folder...: this button allows you to open a folder containing scale definitions in
Scala format (filename extension “.scl”) which will then appear as an additional category in the
Scale Window.

On the Internet, you will find at http://www.huygens-fokker.org/microtonality/scales.html a collection of
over 4,000 Scala files that you can copy to any part of your hard disk and audition and try out in this
way using Melodyne editor.

You can also load scale definitions created in Melodyne studio (filename extension ‘.mts’) with this
button.

Saving a scale

The Scale Window allows you to experiment swiftly and easily with a large number of scales as well
as combine elements of your existing scale with those of the presets in the Scale Window. In the
process, you are bound to hit upon interesting combinations that you will want to save and use again
later. The command “Save Scale As...” allows you to do just that: store your own scale presets so that
you can access them later in the Scale Window. For this purpose, it opens a window that looks very
like that of the Scale Window and offers you the following options.

® Name: here you can enter a name for your scale.

® Category: select the category under which you wish the scale to be filed. Click New Folder to
create a new category.

® |n the text field below, you can enter a comment to be stored along with the scale.

® In the lower part of the window, you can assign names to the mode and tuning. All aspects of a
scale are invariably stored along with it. By placing ticks (checkmarks) here, however, you can
specify which aspects of the scale are considered relevant when it is opened subsequently.
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Editing scales

In the extended scale area, which opens to the left of the Pitch Ruler, you will find the functions for
the editing of scales and creation of new scales.

Displaying the extended scale area

Click on the tuning fork icon beneath the Pitch Ruler to open the extended scale area. To the left of
the Scale and Reference Pitch Rulers, two further rulers will appear: the Mode Ruler and the Tuning
Ruler.

Editing modes

The Mode Ruler allows you to define the degrees of your scale — the mode degrees — and their use.

When you right-click on a degree in the Mode Ruler, a context menu appears, allowing you to assign
to the degree in question any of the following designations:
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® Primary Degree: a degree always used in the scale.

® Secondary Degree: a degree that can be, but is not necessarily, used in the scale.

® Ascending Degree: a degree only used when ascending the scale.

® Descending Degree: a degree only used when descending the scale. A simple example of a
scale in which different notes are used depending upon whether you are ascending or
descending is the melodic minor.

® Non-Scale Degree: a degree made available by the tuning system but not employed by the
scale. Non-scale degrees are grayed out in the ruler.

® Set as Tonic: tells Melodyne to regard the selected note as the first note (or “tonic”) of the
scale. The tonic is indicated by a black outline.

® Set Mode Degree Names: allows you to choose whether the degrees of the scale are indicated
by Roman numerals, solmization or their Indian designations. After double-clicking on a
degree, however, you can type in any designation you prefer.

® |ock Tuning and Mode: By placing the mouse pointer alongside the degree indicator in the
mode menu and dragging upwards or downwards, you can transpose the mode. Normally the
transposition is performed without regard to the tuning of the mode.
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In the case of a scale exhibiting unequal temperament — one, in other words in which adjacent
degrees are separated by varying numbers of cents — a crude transposition of the mode, however,
would disturb the ratios between the various degrees of the scale. Whenever this outcome is
threatened, the “Lock Tuning and Mode” function is activated automatically so that the degrees of the
scale move en bloc and the intervals between the degrees are preserved. If you prefer, however, you
can activate or deactivate this function manually.

The text box at the top of the Mode Ruler (below the word “Mode”) allows you to assign a hame to
your scale.

Tuning . Mode «| Y. Scale v &
Equal Temperam... Major 440 Major b ]
700.0 I i G .
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Editing intervals

The degrees of a scale are defined by a tuning system whereby each degree is a specific distance
from the tuning root. This distance is described as an “interval”. The tuning therefore says nothing
about the absolute pitch but simply expresses the ratios between the various degrees of the scale.

In the Tuning Ruler, you can see these intervals displayed in cents and can edit them. Just drag an
interval upwards or downwards with the mouse to alter its tuning.
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Intervals displayed as frequency ratios

Alternatively, you can define an interval as a frequency ratio. The interval of an octave, for example,
is formed by the ratio 1:2. This is the function of the Ratio Ruler, which appears at the bottom of the
screen when you click on an interval. Melodyne displays there the frequency ratios that are most
relevant: i.e. the ones lying closest to the selected interval.
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_______________________________________________________________________________________________________________________|
The brighter the highlighting, the closer the ratio to the selected interval. If you double-click on one of
the ratios suggested, the Ratio Ruler engages and the cent display of the interval in question is
updated to reflect your choice.

By dragging the upper half of the ruler, you can set any ratio you want. To move the entire ruler, drag
the lower half. If you check the box marked “All” in the Ratio Ruler, Melodyne will no longer preselect
ratios for you but simply display all possible ratios that approximate to the current interval.

Defining intervals

Right-clicking on any interval in the Tuning Ruler opens the following context menu:
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® Insert Interval Above Selection: inserts an interval above the interval selected.

® Remove Interval: removes the selected interval.

® Insert Chromatic Intervals: supplements the existing intervals chromatically through the
addition of further intervals.

® Remove Non-Scale Intervals: removes all intervals foreign to the scale.

® Set as Tuning Root: makes the selected interval the point from which the intervals are
calculated.

® Assigned Note Name: any new interval initially takes the name of the nearest note. Musically,
however, it may be preferable to assign the name of the note above or below it, so this entry
allows you to select an alternative name.

® Round Tuning to Equal Temperament: rounds all intervals to comply with equal temperament.

® Stretch Tuning: opens a window that allows you to apply stretched tuning to your scale (more
on this below).

® Create New Scale Based On ...: opens a window that allows you to create from scratch a new
scale (more on this below).

® Interval Display: This allows you to make the selected interval the display reference for your
tuning system, deactivate the cyclic interval display, and select between cents, hertz and
Turkish commas (=1/53 octave) as display units. These options only affect the display of the
intervals and have no effect on their tuning.

® |nterval Monitoring: if this option is checked, as you alter an interval you can hear the results.

The text box at the top of the Tuning Ruler (below the word “Tuning”) allows you to enter a name for
the tuning system of your scale.

Tuning . Mode o| ¥ | Scale . &
Equal Temperam... Major 440 Major Iy
700.0& I G
600.0
7 ) N ; .
500.0 — | i F Major . 4
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Tip: If you hold down the Shift key and click between two intervals, you can insert a new interval at
the position of the mouse cursor. Hold down the Shift key and double-click on an existing interval to
delete it.

Creating your own scales

To create a scale from scratch, right-click on an interval in the Tuning Ruler and select “Create New
Scale Based on ...” from the context menu. A new window opens offering you the choice initially
between a cyclic and non-cyclic scale.

Generate Scale

Scale Name: New Scale

Cyclic Scale
m ] Cycle: ioo.o cent b
Degrees: 12
hd
1 w Non-Cyclic Scale
“,-._ Interval Size: 100.0 cent |y
‘_'ﬁm Degrees Above: 24 Degrees Below: 0 "\\-(\

Cancel OK

® Cyclic Scale: If you opt for a cyclic scale, you can specify the size in cents of the cycle and the
number of degrees of which it is composed. For a scale that repeats every octave, for
example, the cycle size would be 1200 cents. Tip: you can also enter the cycle size as a ratio:
e.g. “2/1” for an octave cycle.

® Non-Cyclic Scale: Enter the size of the intervals between adjacent notes and the number of
degrees above and below the selected tonic.

® Scale Name: Enter the name of your scale in the text box provided.

® If you exit with OK, Melodyne will generate a scale in accordance with your specifications and

this will become the new scale grid for the current document. Exit with Cancel to revert to the
current scale.

Working with stretch tuning

On upright and grand pianos, the higher registers are generally sharpened slightly and the lower
registers flattened; the tuning, in other words, is “stretched”. If you were now to work in Melodyne with
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equal temperament, the desired stretch tuning would be lost. To avoid this, select Stretch Tuning ...
from the context menu of the Tuning Ruler and a window will open allowing you to define the stretch
curve.

By double-clicking on the graph, you can create handles with which you can drag the curve to obtain
the desired characteristic. Double-click on a handle to remove it.

® Standard Stretching: if you click this button, Melodyne will generate a typical stretch curve,
which you can then further adjust should you so desire.

® Reset Stretching: restores the curve to its starting position.

® Pitch Range: defines the maximum deviation and therefore the vertical range of the curve.

® Exit with OK to implement the stretch curve you have defined or with Cancel to discard your
changes.
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Identifying scales

The Scale Detective analyzes the intervals found in the audio material and their implications for the
mode of the scale. The result is a scale grid that reflects the music analyzed. You can edit, save and
apply the extracted scale to other material, and in this way transmit the special character of one
recording to another.

Showing the Scale Detective and adjusting its sensitivity

Click on the leftmost of the three icons beneath the Pitch Ruler. The “drawer” to the left of the Pitch
Ruler is now fully open.

A new column headed “Detective” appears at the extreme left of the screen displaying the results of
the analysis. The “mountains” lying on their sides in the Scale Detective represent the intervals
detected: the higher the mountain, the more importance is attached by Melodyne to the role of the
interval in question in the mode of the scale.
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The slider at the top of the Scale Detective governs the sensitivity of the analysis and, with it, the
number of intervals detected and displayed. The intervals displayed should correspond as closely as
possible to the intervals actually played. Adjust the sensitivity until only as many intervals are
displayed as the scale in your view contains.

The analysis will take into consideration only the notes selected, unless no notes are selected, in
which case all will be considered.

Scale detection options

A right-click in the Scale Detective opens the following context menu:

200.0 Vi D

LY Reanalyze Scale
Apply Analysis L
Insert Chromatic Intervals During Analysis i C
Keep 'F' as Tonic
Cycle ...
X

JE=T10000 === W —
e
900.0 n A \

® Reanalyze Scale: This command requires the Scale Detective to conduct a fresh analysis of
the scale. The analysis will take into consideration only the notes selected, unless no notes are
selected, in which case all will be considered.

* Apply Analysis: If this option is selected, the results of the analysis will invariably be applied
directly to the current scale grid.

® Analysis Inserts Chromatic Intervals: If this option is selected, the intervals analyzed are
supplemented chromatically by others, which are then regarded as intervals foreign to the
scale (or “non-scale degrees”).

® Keep ... as Tonic: If you click and drag the Scale Detective vertically, you can alter the tonic
upon which the analysis of the audio material is based. When you do so, this option is selected
automatically. The next analysis will then be based upon the tonic you have selected rather
than the one indicated by Melodyne’s current analysis of the material.

® Scale Cycle: opens a dialog box that allows you to choose between a cyclic or non-cyclic
analysis.
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Scale Cycle

() Cyclic Scale
:{ Cycle: | 1200 cent

. Non-Cyclic Scale
’ Lower Limit: 16 Hz Upper Limit: 8367 Hz ’

® Cyclic Scale: selects a cyclical scale analysis. You can enter the size of the cycle in cents or
as a ratio: e.g. “2/1” for a scale that repeats every octave.

® Non-Cyclic Scale: selects a non-cyclic scale analysis the upper and lower limits of which in
hertz (Hz) you are free to choose. The analysis will then consider only notes lying within the
range specified.

® When you exit the Scale Cycle dialog with OK, a fresh analysis of the material will be
conducted at once, based upon your new settings. If, on the other hand, you select Cancel,
Melodyne will revert to the existing analysis.

Applying the detected scale.

To apply the detected scale to the current scale grid, check the option Apply Analysis in the context

menu of the Scale Detective. You can then edit, save and apply to other material your new scale just

like any other.

© Celemony Software GmbH 2021 « Last updated on 03/23/2021 « Help Center « www.celemony.com

73


http://helpcenter.celemony.com/hc-2/?lang=en&startPageEdition=melodyne-editor
http://www.celemony.com

Melodyne 4 editor - DAW without ARA

Selecting notes

In this tour, you will learn which techniques you can use to select notes in Melodyne prior to editing
them.

Standard selection techniques

Click a note in the Note Editor to select it. Selected notes are more boldly colored.

J
i hT )
= = _F

[S —
[Command]-click additional notes to add them to the selection.

[Command]-clicking a selected note removes it from the selection.

Another way of selecting multiple blobs is to lasso them by clicking the background in one corner of
the desired selection and then dragging the pointer to the corner diagonally opposite. This is
sometimes called rubber-banding. If you hold down the [Command] key, you can add a further rubber-
band selection to the existing one. You can also add individual notes to the selection (or remove them
from it) by [Command]-clicking.

Cc

Bb

i
_ Sy

To select a passage (i.e. a series of notes), click the first note of the series and then [Shift]-click the
last (or vice versa).
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Snake selection

If you press the [Shift] key, click a note and then move the mouse pointer away, Melodyne’s snake
selection mode is activated. You can now add notes to the selection by painting over them with the

If you move the mouse (and thereby the snake) backwards again, you can remove notes previously
painted over from the selection.

=
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Selection using the Pitch Ruler

Click a note in the Pitch Ruler to select notes of the corresponding pitch.

y -Tﬂcfmf-'

)

If cycle mode is active, the selection only affects such notes if they lie within the cycle range.
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By [Command]-clicking other notes in the Pitch Ruler, you can add them to the selection and later
remove them by the same means.

If you double-click, as opposed to single-clicking, a note in the Pitch Ruler, you will select the same
note in all octaves rather than simply that single instance of the note.

Click and drag in the Pitch Ruler to select a range of notes.

a

N\H:/'Jw

v

F1

M ws)

By using the [Command] key in the Pitch Ruler, you can remove from the selection a range of notes

or individual notes. Here too, if a cycle is active, only notes within the cycle range will be selected.

Selection commands in the menu

In the Edit menu and the context menu of the Note Editor, you will find the command Select All and
the Select Special sub-menu, which contains a number of more sophisticated options.

The command Restore Last Selection reverses the last selection step, thereby restoring the selection
that was active beforehand. This is useful if you are in the process of performing a complex selection
and accidentally shoot astray, causing the selection to disappear. By clicking Restore Last Selection,
you can retrieve it.

The command Invert Note Selection deselects all selected notes and selects all notes that were
previously not selected. The commands that follow are similarly self-explanatory, allowing you to
select all the notes that follow, all notes of the same pitch, all notes of the same pitch in all octaves,
and so on.

The command Select Fifths Above and Below in All Octaves selects tones a fifth above and below the
selected tones in all octaves. All the Select commands in the second subdivision of the menu operate
on the cycle zone only if cycle mode is active.

The two commands that follow, Select Same Beat in All Bars and Select Notes Between Locators, are
also self-explanatory. The last command in the list, Rotate and Select Hidden Notes is designed to
help out when you have notes that overlap or completely cover others. It does so by switching the
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display from layer to layer, selecting at each successive layer the newly revealed note, so that you
can see it more easily and drag it.
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The Correct Pitch Macro is used to rectify poor intonation quickly and intelligently and rein in any
undue wavering in pitch.

Opening and using the macro

Select the notes you wish to edit. If no notes are selected, macro editing will by default affect all notes.

To open the macro, choose Edit > Quantization Macros > Correct Pitch or click on this button at the
top of the Note Editor.

A1 +2 ct < o

Here, with the upper slider, you can apply a degree of correction ranging in intensity from 0% (no
influence) to 100% (full power) to the pitch center of the notes selected. By default, such notes are
moved towards, or to, the nearest semitone, but if you check the option “Snap to (the selected
scale)”, notes foreign to the scale will be ignored as possible destinations, and, depending upon the
position of the slider, notes will move a certain distance towards, or all the way to, the nearest degree
of the scale in question.

A word of caution here: notes often fluctuate slightly in pitch, so their position is based on a mean
pitch that Melodyne has to calculate. This mean pitch, or “pitch center”, forms the basis for pitch
correction. If a note wavers slightly in pitch, it cannot be guaranteed that, after 100% correction has
been applied to it, it will sound right at the new pitch — especially since the correct pitch of any given
note is not a constant but depends upon the musical context.

The macro works in a musically intelligent manner: At lower settings it affects only those notes that
are wildly out of tune, leaving untouched those that are already quite close to the intended pitch. As
the slider is moved further towards the right, however, even those notes are influenced, and to an
increasing degree, until at 100% all the selected notes are exactly in tune.

The pitch center, which the macro adjusts automatically, is the same parameter that is modified when
pitch correction is performed manually using the Pitch Tool.
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Correct Pitch

Pitch Center: 80 %
—
— — Pitch Drift: 22 %
— Snap to F Major
— Include notes fine-tuned manually Cancel OK
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With the lower slider, you can progressively reduce the amount of pitch drift exhibited by the notes in
guestion. By “pitch drift”, we mean the kind of slow wavering in pitch that is symptomatic of poor
technique. More rapid fluctuations in pitch, such as pitch modulation or vibrato, remain unaffected.

You can modify both correction parameters in real time as the audio plays back; and hear, but also
see (by the movement of the blobs in the Note Editor, the effect of different settings.

If you have already fine-tuned some notes using the Pitch Tool, Melodyne will assume you

are satisfied with the results; this means that, by default, if you now open the Correct Pitch Macro with
no notes selected and begin making changes, only the other notes will be affected. By default, in
other words, notes that have been tuned manually are not affected by the macro. If you wish the pitch
of these too to be affected by the macro, check ‘Include notes fine-tuned manually’. The option is
grayed out, of course, as being of no relevance, if no manual editing of intonation has been
performed.

Closing the macro and correction values when it is reopened

Exit with OK to keep your changes or Cancel to discard them. Naturally the fact that you have used
the Correct Pitch Macro in no way precludes your fine-tuning notes at any time subsequently by hand.

If you select a note that has already been edited using the macro and then open the macro again, the
settings previously applied to it will be displayed; the macro remembers, in other words, the
parameters previously applied to each note. If the current selection includes notes to which different
settings have been applied, when it is opened the minimum and maximum values for each parameter
will be displayed.

Even after exiting with OK, you can still reverse the effects of the macro editing by using the undo
function.
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Quantize Time Macro

In this tour, you will learn how to work with the Quantize Time Macro, which makes it possible to
correct the timing of notes swiftly and effortlessly.

Quantizing timing: What is moved and where to?

Before examining the operation of the Quantize Time Macro, we should clarify a few basic concepts
and relationships.

To understand these better, let's begin by selecting the Time Tool. When this is active, a note
separation (indicated by a vertical dash) or the musical starting point of the note (indicated by a
vertical dash with a triangle) appears near the start of each blob.

Now check Show Intended Notes in the Options > Note Editor sub-menu, which can also be
accessed via the cog icon in the top right-hand corner of the Note Editor.

Gray boxes now enclose each blob.

When it first analyzes the material, Melodyne calculates for each note two parameters of relevance to
the process of time correction.

The first is the intended musical beat of the note; this is indicated by the start of the gray frame
enclosing the blob. As you can see, the start of the frame invariably coincides with a grid line.
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The second is the the beginning or musical starting point of the note, represented, respectively, by a
note separation or a vertical dash with a triangle. This will not necessarily be aligned with the left-
hand extremity of the blob. Think of a brass instrument, for example, where each actual note is often
heralded by a certain amount of wind noise. Admittedly this noise belongs to the note, but from the
standpoint of timing what is of relevance is the moment the sound really unfolds and the pitch first
becomes discernible; that is the timing-critical moment.

It may not always be possible to determine when this occurs, in which case only the beginning of the
note will be marked. (Starting points can be edited in Note Assignment Mode).

If you quantize notes with the Quantize Time Macro, the musical starting point of each note (if one
has been determined; if not, the beginning of the note] will move towards the left-hand side of its gray

frame. The quantization intensity slider determines whether it goes all of the way, or only part of the
way, to the beat assigned it.

A note about time quantization in polyphonic audio material: With polyphonic material, as well as
anchors with triangles, there are anchors without them. Notes the anchors of which have no triangle
are in a temporal relationship with another note with a triangle and are therefore treated differently
during quantization. If you play a C on the piano and immediately afterwards an E, the C can also
contain starting transients belonging to the E. The C here gets a marker with a triangle; the E, one
without. To move these two notes for no good reason by different amounts during quantization might
not make much sense musically and could even produce tonal artifacts.

The following rules therefore apply: If during quantization both notes are selected, the note with the
triangle and that without it will move towards the marker by exactly the same amount. There is here,
in other words, a master-slave relationship. If you have only selected the note with the triangle
marker, only this will be quantized. If you have only selected the note without the triangle marker, no
guantization will take place. The same goes for a multiple selection. Naturally, you can move all and
any of the notes manually if you are not satisfied with the way they sound together.

In the case of chords, it is the selection that determines the quantization behavior: If the Notes of the
chord are selected individually, one after the other, and quantized, they behave as described above,
moving individually towards the grid lines. In this way, for instance, you can ensure that the notes of a
strummed chord on the guitar (which sound in quick succession) end up sounding simultaneously —
an effect impossible technically for a player to realize but one that might be musically desirable.
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If, on the other, prior to quantization, you select all the notes of the chord, each will travel the same
distance. The internal timing of the chord — in our guitar example, the intervals of time separating the
start of successive notes, and therefore the authenticity of the effect — will be preserved. The chord,
after quantization, will sound exactly as it did before; the difference being, of course, that it will no
longer sound ‘too soon’ or ‘too late’.

The value by which all the notes are moved forward or backwards in time is determined by the note
lying closest to the mathematical mean between the first and last note of the chord. In the case of a
six-string guitar chord, this is generally the note sounding on the third or fourth string. If you want the
sounding of some other string to coincide with the grid line, of course, you can always give the whole
chord a little shove.

Opening the Quantize Time Macro and setting the parameters

Select the notes you wish to edit. If no notes are selected, macro editing will by default affect all
notes.

To open the Quantize Time Macro, choose Edit > Quantization Macros > Quantize Time or click the
Quantize Time icon (illustrated here) to the right of the toolbar in the Note Editor.
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First, the Groove Reference (if any) that will govern the time correction must be selected.

If Auto is selected, the target (or ultimate destination) of any quantization will be the left-hand edge of
the gray frame, as already described. This is invariably aligned with the grid line that represents the
beat to which Melodyne, in the course of its analysis, assigned the note. (On the whole, the system
functions very well; but it can happen that Melodyne gets it wrong, and that after

guantization you have to move the note manually to the preceding or following beat.) By selecting
Auto, in other words, you are telling the Quantize Time Macro to move notes to (or towards) the beats
assigned them by Melodyne based on its own analysis of the material.
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With the other buttons, you can select the target grid for the quantization. The ‘T’ next to the note
values stands for the corresponding triplet. If you select 1/4 as the Groove Reference, to give one
example, the grey frames will move to the nearest quarter-note (or ‘crotchet’) and this will then
become the ultimate destination for any quantization.

Note that the time correction macro works differently from, and in a more musical fashion than, the
guantization typically offered by MIDI sequencers. Instead of simply causing all notes to snap to the
selected grid, it edits the points of rhythmic emphasis of the selected notes. If, for example, you take
a passage containing successions of sixteenth notes (semiquavers) and quantize it to quarter notes
(crotchets), the beginning of each succession of sixteenth notes will be moved to the nearest quarter
note. The timing of the semiquavers within the sequence, however, remains unaltered. If you wish to
tidy that up as well, you can do so in a second pass, taking each semiquaver sequence in turn and
using sixteenth notes as the quantization factor.

The Intensity slider determines what percentage of the distance to this ultimate destination the notes
will travel in the course of quantization. If you select 0%, for example, they’ll not budge; 50%, and
they’ll go half way; 100%, and they’ll travel the full distance, ending up precisely on the beat. You can
modify both the Groove Reference and the Intensity of the quantization in real time as the audio plays
back; and hear, but also see (from the movement of the blobs in the Note Editor), the effect of
different settings.

If you have already finely adjusted the position of notes using the Timing Tool, Melodyne will assume
you are satisfied with the results; this means that, by default, if you now open the Quantize Time
Macro with no notes selected and begin making changes, all notes will be affected except these. If
you wish the position of these too to be affected by the macro, check ‘Include notes fine-tuned
manually’. The option is grayed out, of course, as being of no relevance, if no manual editing of note
positions has been performed.

Closing the macro and correction values on reopening

Exit with OK to keep your changes or Cancel to discard them. Naturally, the fact that you have used
the Quantize Time Macro in no way precludes your moving notes at any time subsequently by hand.
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If you select a note that has already been edited using the macro and then open the macro again, the
settings previously applied to it will be displayed; the macro remembers, in other words, the
parameters previously applied to each note. If the current selection includes notes to which different
settings have been applied, a mean value for each parameter will be displayed.

Even after exiting with OK, you can still reverse the effects of the macro editing by using the undo
function.
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Melodyne’s Main Tool is context-sensitive, its exact function at any given moment depending upon its
position relative to the selected blob. It has no unique functions but simply offers a different mode of
access to functions it shares with the more specialized tools for editing pitch, timing and note
separations, combining them in such a way that you can perform the most essential editing tasks
without ever having to change tools.

Modifying the pitch and timing of notes

Select the Main Tool (denoted by an arrow) from either the toolbox or the context menu of the Note
Editor or by pressing the [F1] key of your computer keyboard. (If you wish to assign a different
shortcut to this tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing
Tools from the main menu.)
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With the Main Tool, move the arrow to a point near the center of a blob and press and hold the
mouse button as you drag it upwards or downwards (to alter its pitch) or left or right (to move it
forwards or backwards in time). It is the initial movement (whether vertical or horizontal) that decides
whether the pitch or timing of the note is altered. Before changing axis, you must first release the
note. If you hold down the [Alt] key as you drag the note, the Pitch Grid or Time Grid, even if active,
will temporarily be ignored, allowing you to position the note exactly where you want it.

S
While you are dragging a note up or down, you will hear the frozen sound of the note at the point
where you clicked. If, whilst dragging, you move the mouse to the right or left, you can put other parts
of the note under the acoustic microscope. If you do not wish to monitor pitch changes in this way,
uncheck the option Monitor When Editing Blobs in the Options > Note Editor sub-menu, which can
also be accessed via the cog icon in the top right-hand corner of the Note Editor.
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Modifying note lengths

Open the Note Editor Options menu and check Show Blob Info. Zoom in on a few individual blobs, so
that you can study them more closely. Now, as you move the mouse pointer over a blob, thin lines
appear indicating the zones in which the Main Tool performs particular functions. For illustrative
purposes, the lines here have been drawn more boldly than in the program itself. The central area
you already know about. This has to be distinguished from the front, back and upper regions of the
blob. As you move the mouse pointer from one of these regions to another, it changes its appearance
to emulate whichever of the more specialized tools is most appropriate to that zone — adopting its
functions at the same time.

Drag the front part of a note to the right or left. Hold down the [Alt] key as you do so if you wish to
override an active time grid. Now only the beginning of the note moves; the end remains anchored, so
the note is either being stretched or compressed.
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In the same way, you can move only the rightmost part of the blob (corresponding to the end of the
note).

Notice that as you move the beginning or end of a note in this way, the preceding or following note, if
adjacent, is also either stretched or compressed by the same amount to avoid either the two notes
overlapping or white space (silence) appearing between them. This type of relationship exists
whenever a pitch transition between consecutive notes has been detected. By moving the adjacent
note as well, Melodyne ensures that discontinuities are avoided and the musicality of the phrasing is
preserved.

If this behavior is not what you want, you can change the ‘soft’ separation between the notes into a
‘hard’ one using the Separation Type Tool. Instead of the separation line, a bracket will then appear
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between the two notes to indicate that no further connection exists between them. You will find the
Separation Type Tool beneath the Note Separation Tool in the toolbar.
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Editing note separations

If you move the mouse pointer to the upper part of a note (above the horizontal line), the Main Tool
adopts the appearance, and emulates the functions, of the Note Separation Tool. If you double-click
now, you can create a note separation — i.e. slice the note in two.

2
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Don'’t be surprised if the two notes that result move apart in pitch: this is because a new tonal center
is calculated for each of the newly created notes, and that may differ from the tonal center they
shared when they were one note. In such cases, each therefore moves to a new vertical position
based on its newly calculated pitch center.

You can move an existing note separation horizontally with the Note Separation Tool. Before you
begin, choose Options > Note Editor Options and check Show Note Separations.

You can double-click a note separation to remove it.
If you select several notes and move a note separation, the note separations of the other selected

notes will also be moved. If you double-click one of the note separations to remove it, those of the
other selected notes will also be removed.

If you have selected several notes that overlap, you can simultaneously insert a note separation at
the same point in all of them, as well as move or remove one.
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The Pitch Tool edits the central emphasis of the pitch of each note. This is the ‘pitch center’ note
parameter that can also be edited using Melodyne’s Main Tool.

Shifting the pitch center

Select the Pitch Tool from either the toolbox or the context menu of the Note Editor or by pressing the
[F2] key of your computer keyboard. (If you wish to assign a different shortcut to this tool, you may do
so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.)

The Pitch Tool is the topmost of the three pitch editing tools. It is responsible for the pitch center of
each note, which can be thought of as its center of gravity. Melodyne allows you to edit the pitch
center of notes independently of any modulation or drifting in pitch they exhibit. Press the [F2] key
twice and three times in quick succession to select, respectively, the first and second sub-tools of the
Pitch Tool. From the Preferences dialog, you can also, if you wish, define separate keyboard
shortcuts for all three tools.

c (2 e I

Drag a note up or down with the Pitch Tool to alter its pitch. If the note is one of several selected, all
the notes in the selection will move up or down en bloc.
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Depending upon whether No Snap, Chromatic Snap or Scale Snap is selected, notes can either be
moved freely or will snap to the nearest semitone or note of the selected scale.

Hold down the [Alt] key as you move notes if you wish the selected grid to be ignored; this will allow
you to position the note freely.
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Monitoring pitch shifts

As you move a note in pitch, you will hear the ‘frozen’ sound of the note at the position clicked. By
moving the mouse to the left or right whilst doing so, you can put other parts of the note under the
acoustic microscope. If you do not wish to monitor pitch changes in this way, uncheck the option
Monitor When Editing Blobs in the Options > Note Editor sub-menu, which can also be accessed via
the cog icon in the top right-hand corner of the Note Editor.

If several notes sound simultaneously at that point, you can hear not only the note being moved but
also its harmonic context, which is very useful if, for example, you wish to construct chords. To do
this, press and hold the [Command] key once you have begun to move the note and you will hear the
frozen sound of all the notes of the chord at the position in question.

Editing pitch with the inspectors

As an alternative to editing the selected notes with the Pitch Tool, you can enter the desired value for
the note and the deviation in cents from equal temperament in the inspector near the toolbar or the
Note Inspector. The Note Inspector also allows you to determine the frequency in hertz of the note or
notes selected. In each case you can increase or decrease the current value by clicking in the
relevant box and dragging the arrow upwards or downwards.

When typing values into the Pitch field, you can enter either absolute values (C3, D4 etc.) or relative
ones (+2, -1, etc.).
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If you have selected several notes that differ in pitch, three hyphens are displayed in the boxes —
followed, as you click in the box and drag, by values describing the extent of the relative change.
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Correcting pitch with a double click

You can see that a note is sharp or flat from the fact that it doesn’t lie plumb in the middle of any of
the horizontal lanes in the editing display. These represent the notes of the chromatic scale, the note
in question, in each case, being indicated by the vertical Pitch Ruler to the left of the Note Editor. If,
with the Pitch Tool selected, you now double-click the offending note, it — and any other notes
selected at the same time — will ‘snap to the grid’, which means each will move instantly to the very
center of the lane representing the semitone nearest to it in pitch.
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A word of caution here: notes often fluctuate slightly in pitch, so their position is based on a mean
pitch that Melodyne has to calculate. This value, which we call their pitch center, forms the basis for
any pitch quantization. If a note fluctuates slightly in pitch, it cannot be guaranteed that after snapping
directly to the nearest semitone during quantization it will sound ‘right’ at the new pitch — especially
since ‘correct pitch’ is not an absolute, but something that depends at all times upon the musical
context.

Pitch transitions

When one note follows another and a tonal relationship between the pair has been detected, the pitch
curve is drawn through them, and in the area between them a thick orange line is displayed that
represents the pitch transition.

If you position the Pitch Tool over the rear part of a note, click and drag vertically, you can make the
pitch transition steeper or less steep.
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Pitch transitions only exist between adjacent notes between which there is a soft separation. By
clicking on a soft separation with the Separation Type Tool (the sub-tool of the Note Separation Tool),
you can transform it into a hard separation, thereby deactivating all association between the two
notes and with it the pitch transition.
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Resetting individual edits and introducing random deviations

In the Edit > Reset Individual Edits > Pitch cascading menu, you will find a variety of commands that
can be used to reverse the effects of particular types of pitch editing, thereby restoring specific
aspects of the notes selected to their original state. The commands apply only to the current selection
and are grayed out whenever no editing of the type in question has yet been applied to the notes
concerned. Note that these commands operate entirely independently of the normal undo function!

With the commands in the Edit > Add Random Deviations sub-menu, you can randomly alter the pitch
of the notes currently selected — introducing either slight, moderate or drastic deviations from the
original intonation. You can also employ the commands several times in succession to intensify the
effect. These commands are useful when, for example, you've doubled a track in order to obtain a
fuller or ‘fatter’ sound. By introducing random deviations, so that the copy is no longer identical to the
original, you can simulate more realistically the effect of two performers playing or singing in unison.
All these commands affect only the selected notes and are therefore grayed out if no notes are
selected.
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The term ‘pitch modulation’ covers rapid and usually intentional variations in pitch such as trills or
vibrato. ‘Pitch drift’ is our term for slow fluctuations in pitch of the kind that are usually unintentional
and symptomatic of poor technique. You will find the tools for editing these parameters beneath the
Pitch Tool in the toolbar.

Editing pitch modulation and drift

Select the Pitch Modulation or the Pitch Drift Tool from either the toolbox or the context menu of the
Note Editor or by pressing the [F2] key of your computer keyboard.

The Pitch Modulation Tool is the first, and the Pitch Drift Tool the second, sub-tool of the Pitch Tool.
Press the [F2] key twice in quick succession to select the former and three times in quick succession
for the latter. (If you wish to assign a different shortcut to this tool, you may do so after choosing
Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.) There, if you wish, you
can also define separate keyboard shortcuts for all three tools.
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With the tool selected, click on a note and — without releasing the mouse button — drag up or down.
The note edited could be part of a multiple selection, in which case you will be editing all the selected
notes simultaneously. Watch as the pitch curve changes shape.
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Drag far enough downwards and the modulation or drift are reduced to zero and then inverted.
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If you double-click a note with the Pitch Modulation Tool or the Pitch Drift Tool, you will restore the
pitch modulation or drift of the original recording, assuming you've changed it, otherwise eliminate it
altogether. Subsequent double-clicking toggles between the original modulation or drift and none. If
you eliminate altogether both the modulation and the drift, you will get an unnaturally flat monotone
that can be suitable for effects.

The inspector for pitch modulation and drift

As an alternative to editing selected notes with these tools, you can enter the desired values in the
inspector alongside the toolbar or in the Note Inspector. Drag the existing value to change it or double-
click on it and type in the value desired.
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With the Pitch Modulation Tool or the Pitch Drift Tool selected, the inspector displays values in
percentage terms. 100% represents in this case the original modulation or drift, 0% a straight line,
and -100% the same curve inverted with its axis unchanged. If you have selected several notes with
different values, a dash is displayed in the box — followed, as you click in the box and drag, by values
describing the extent of the relative change.

The Reset commands

In the Edit > Reset Individual Edits > Pitch cascading menu, you will find a variety of commands that
can be used to reverse the effects of particular types of pitch editing, thereby restoring the notes
selected in specific respects to their original state. These commands relate always to the current
selection and are grayed out if no editing of the type in question has been applied to the selected
notes. Note that these commands operate independently of the normal undo function.
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Formant Tool

Formants are areas of emphasis or attenuation in the frequency spectrum of a sound that are
independent of the pitch of the fundamental note but are found always in the same frequency ranges.
They are characteristic of the tone color or ‘timbre’ of each sound source, and interesting effects can
be produced by shifting them, such as making a man’s voice sound like that of a woman, and vice
versa.

Shifting formants

Select the Formant Tool from either the toolbox or the context menu of the Note Editor or by pressing
the [F3] key of your computer keyboard. (If you wish to assign a different shortcut to this tool, you
may do so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.)
A beam appears over the blobs indicating the extent (if any) to which the formants have been
transposed from their original pitches.
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With the tool selected, click on a note and — without releasing the mouse button — drag the mouse up
or down. As you do so, the formants will be transposed upwards or downwards, the degree and
direction of the movement being indicated by a corresponding vertical movement of the beam.
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The beams indicate the distance in cents (100 cents = 1 semitone) by which the formants have been
transposed upwards or downwards. You can shift the formants a few cents (for the finest of nuances)
or several thousand (for a drastic denaturing of the sound). Double-clicking on a note with the
Formant Tool restores its formants (as well as those of any other notes selected) to their original
pitches.

The inspector for the formants

As an alternative to editing selected notes with the tool, you can enter the desired values in the
inspector, which you will find alongside the toolbox or in the Note Inspector. Drag the existing value to
change it, or double-click on it and type in the value desired.
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If you have selected several notes that differ in the amount of formant shifting that has been applied
to them, a dash is displayed — followed, as you click in the box and drag, by values describing the
extent of the relative change.

N

Formant transitions

A thick orange line appears between the formant beams of adjacent notes as soon as you shift the
formants of one note more, or in a different direction, than those of the other. This line represents the
formant transition between the two notes.
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If you move the Formant Tool to the end of the first note, it changes into the Formant Transitions
Tool. Dragging vertically with this tool governs the speed of the formant transition, which is indicated
by the steepness of the connecting line.

= |
Formant transitions only exist in the case of adjacent notes between which there is a soft note
separation. If you transform this into a hard note separation by double-clicking with the Note

Separation Type Tool (the sub-tool of the Note Separation Tool), all association between the notes
will be severed and the formant transition between them deactivated.

The Reset commands

In the Edit > Reset Individual Edits > Formants cascading menu, you will find a pair of commands that
can be used to reverse the effects of any shifting of formants or editing of formant transitions you may
have performed, thereby restoring the notes selected in these respects to their original state. These
commands relate always to the current selection and are grayed out if no editing of the type in
guestion has been applied to the selected notes. Note that these commands operate independently of
the normal undo function!
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The Amplitude Tool allows you to adjust the amplitude (i.e. volume) of the selected notes, edit the
amplitude transitions between them, and mute them.

Editing amplitude

Select the Amplitude Tool from either the toolbox or the context menu of the Note Editor or by
pressing the [F4] key of your computer keyboard. (If you wish to assign a different shortcut to this
tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the
main menu.)
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With the tool selected, click on a note (or one of several notes selected) and — without releasing the
button — drag the mouse up or down. The vertical depth of the blobs will increase or decease as the
notes they represent get louder or softer.
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The gearing of the amplitude adjustment is dependent upon the vertical zoom resolution. Press and
hold the [Alt] key, to switch to smaller increments for finer adjustment.

Editing amplitude using the inspectors

As an alternative to editing selected notes with the Amplitude Tool, you can enter the desired values

in the inspector to the right of the toolbar or the Note Inspector. Drag the existing value to change it or

double-click on it and type in the value desired. Press and hold the [Alt] key, to switch to smaller
increments for finer adjustment.
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If you have selected several notes to which different amplitude adjustment has been applied, a dash
is displayed in the box — followed, as you click in the box and drag, by values describing the extent of
the relative change.

Amplitude transitions

A thick orange line appears between connected notes as soon as you change the amplitude of one
note more, or in a different direction, than that of the other. This line represents the amplitude
transition between the two notes. If you move the Amplitude Tool to the end of the first note, it
changes into the Amplitude Transitions Tool. Dragging vertically with this tool governs the speed of
the amplitude transition, which is indicated by the steepness of the connecting line.
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Amplitude transitions only exist in the case of connected notes between which there is a soft note
separation. If you double-click on the separation with the Separation Type Tool (which you will find
beneath the Note Separation Tool in the toolbar), you turn the soft note separation into a hard one,
thereby disconnecting the two notes and deactivating the amplitude transition.

Muting notes

Double-clicking with the Amplitude Tool on one or more selected notes mutes them. Only the outline
of the blobs is now shown, to indicate that the notes in question have been muted, but you can still
select and edit them. A further double-click unmutes the muted notes.
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In the Note Inspector, you will find a button marked Note Off for this function. Click once on the button
to mute the selected notes. Clicking them a second time unmutes them.
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The reset commands

In the Edit > Reset Individual Edits > Amplitude cascading menu, you will find two commands that can
be used to reverse the effects of the two types of amplitude editing we have just described (thereby
restoring the notes selected in certain respects to their original state) as well as the Unmute
command, which is self-explanatory. These commands relate always to the current selection and are
grayed out if no editing of the type in question has been applied to the selected notes. Note that these
commands operate independently of the normal undo function.
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The Timing Tool allows you to edit the horizontal position and length of notes with or without
guantization.

Modifying the position and length of notes

Select the Time Tool from either the toolbox or the context menu of the Note Editor or by pressing the
[F5] key of your computer keyboard. Press the [F5] key twice or three times in quick succession to
select, respectively, the first or second sub-tools of the Time Tool. (If you wish to assign a different
shortcut to this tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing
Tools from the main menu.) There, if you wish, you can also define separate keyboard shortcuts for
all three tools.
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Click the center of a note (or of one of a number of selected notes) and drag it to the left or right to
move the entire note (or notes) horizontally. Press and hold the [Alt] key during the movement if you
wish the time grid to be temporarily ignored to permit finer adjustment.
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If you only wish to move the beginning of a note but not the end, click on the front part of the note and
drag. Depending on the direction of movement, the note will be time-stretched or -compressed. Press
and hold the [Alt] key if you wish the Time Grid to be ignored when editing. Stretching and squeezing

also acts upon either a single note or a multiple selection of notes according to choice.

-
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In the same way, you can move only the rightmost part of the blob (which corresponds to the end of
the note) or selection of blobs to stretch or squeeze the corresponding note or notes.

Timing changes in the case of connected notes

Notice that as you move the beginning or end of a note in this way, the preceding or following note, if
adjacent, is either stretched or compressed by the same amount to avoid either the two notes
overlapping or white space (silence) appearing between them. This is invariably the case when one
note follows directly on from another and there is a soft note separation between them. By moving the
adjacent note as well in this way, Melodyne prevents discontinuities occurring and preserves the

musicality of the phrasing.
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You can, if you wish, deactivate the connection between consecutive notes by transforming the soft
note separation between them into a hard separation. This is done by clicking on it with the
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Separation Type Tool (which is a sub-tool of the Note Separation Tool).

All connection between the two notes will also be forcibly severed if you cut one of the notes and
paste it into a different location.

In both cases, when the note separation line between the two notes is replaced by a square bracket,
it means that the notes are no longer connected.

If you move one of the two notes far enough from the other using the Timing Tool, the link between
them will also “snap”. In this case, however, if you move it back, the original link will be restored —
provided the position of the other note has not been moved in the meantime and that you have not
changed tools.
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Correcting timing with a double-click

If you double-click a note with the Timing Tool, it (and any other notes selected) will snap to the
selected grid — for example, to one of the subdivisions on the second ruler or one of the vertical lines
indicating the start of an eighth-note. As a result, the musical beginning of the note will come to rest
directly on top of the nearest grid line.

The musical starting point of a note is indicated by a vertical dash with an anchor at the top, and is
found somewhere near the start of the blob but not necessarily at its leftmost extreme (which we call
the ‘physical beginning’ of the note). Melodyne defines the musical starting point of the note to be the
point at which the sound has unfolded sufficiently for the pitch to become discernible, as it is this
moment that is of relevance for the purpose of quantization. Not every note, however, has a musical
starting point. If none is present, the physical beginning of the note is used as the basis of
guantization. (The musical starting point of notes can be edited in Note Assignment Mode).

For a note to snap to the nearest grid line, however, there must be sufficient room; if an adjacent note
that is connected to the edited note is in the way and cannot be squeezed enough to create the
requisite space, quantization of the note to the desired grid will be impossible. In such cases, notes
are quantized to the nearest possible value, such as the eighth-note (quaver) nearest the desired
quarter-note (crotchet).

If no grid is active, a note will be quantized to its ‘intended’ beat — i.e. to that indicated by the left side
of the grey frame enclosing it. This is the beat upon which, according to Melodyne’s analysis, it was
intended to fall.

Note: it is not possible to quantize to entire bars: only to fractions of bars.
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In chords, it is the selection procedure that determines the quantization behavior: If the notes are
selected and quantized individually, one after the other, they will behave as described above and
move individually to or towards the grid. This could result, for example, in the notes of a chord
strummed on the guitar, which originally sounded in quick succession, sounding simultaneously — an
effect technically impossible for the performer to achieve but which might nonetheless be musically
desirable.

If, on the other hand, all the notes of the chord are selected and quantized simultaneously, each note
will then travel the same distance in time. The internal timing of the chord — in the guitar example, the
interval of time separating the sounding of successive strings — and therefore the authenticity of the
technique, will be preserved. The chord, in other words, will sound after quantization exactly as it did
before — but no longer “too early” or “too late”.

The distance in time through which all the chord members travel is determined by the note lying
closest in time to the halfway point between the sounding of the the first and last notes of the chord.
In the case of a chord strummed on a six-string guitar, this is likely to be the note played on the third
or fourth strings. You can always move the chord by hand if you would prefer the sounding of some
other string to coincide with the grid line.

Adding random deviations

With the commands in the Edit > Add Random Deviations sub-menu, you can randomly alter the
timing of the notes currently selected — introducing either slight, moderate or drastic deviations from
the original timing. You can also employ the commands several times in succession to intensify the
effect. These commands are useful when, for example, you've doubled a track in order to obtain a
fuller or ‘fatter’ sound. By introducing random deviations, so that the copy is no longer identical to the
original, you can simulate more realistically the effect of two performers playing or singing in unison.
All these commands affect only the selected notes and are therefore grayed out if no notes are
selected.

The reset commands

In the Edit > Reset Individual Edits > Time sub-menu, you will find a number of commands that can
be used to reverse the effects of whatever editing has been performed on the timing. These
commands apply always to the current selection and are grayed out if no editing of the type in
guestion has been performed on the notes selected. Note that these reset commands work quite
independently of the normal Undo command.
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The Time Handle Tool and the Attack Speed Tool are found below the Timing Tool in the toolbar.
Their purpose is to allow you to adjust the internal time path and envelope of notes.

How time handles and the Attack Speed Tool work

Time handles are handles you can affix to particular stages in the evolution of a note and drag
sideways in order to advance or retard their attainment. In this way, you can accelerate or slow down
particular phases of a note’s development in order to fine-tune the musical phrasing.

The Attack Speed Tool also affects the speed at which a note evolves: either by stretching and
slowing down its early development phase and thereby accelerating its later development, or vice
versa.

The result is either a slower, softer attack or a faster, harder one. The ‘perceived’ musical starting
point of the note, however, remains unchanged.

Modifying the evolution of notes using time handles

The Time Handle Tool is the first of the two sub-tools of the Time Tool. To select it, press the [F5] key
twice in quick succession. (If you wish to assign a different shortcut to this tool, you may do so after
choosing Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.) There, if you
wish, you can also define separate keyboard shortcuts for all three time tools.

(o IR | S |da| &) o 4 g || e
]

Zoom in on the note you wish to edit, so that you can see it clearly and position the time handles
more precisely. Now double-click the point in the note’s evolution that you wish to advance or retard.
A time handle will appear that you can move forwards or backwards in time by dragging the tool
respectively upwards or downwards. Since the overall length of the note remains unchanged, the
result is to shorten and accelerate the phase of the note’s development lying to one side of the time
handle while lengthening and slowing down the phase the other side.
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You can attach multiple time handles to a single note, moving each one individually, thereby
influencing fine details of the note’s evolution. There is no limit to the number of time handles that can
be attached to a single note. Melodyne does, however, impose constraints as to how close to one
another the handles can be placed. If ever you find you cannot place a time handle exactly where you
want it, try a little further along.

If you select multiple time handles using the usual selection techniques, you can move them all en
bloc.

k
—

Double-clicking on a time handle or a selection of time handles removes them, thereby causing the
affected phases of the note to evolve at their original speeds.

By choosing Edit > Reset Individual Edits > Time > Remove Time Handles from the main menu, you
can remove the time handles from all the selected notes.

Changing the attack speed of notes

The Attack Speed Tool is the second sub-tool of the Time Tool. To select it, press the [F5] key three
times in quick succession. From the Preferences dialog, you can also, if you wish, define a separate
keyboard shortcut for this tool.

Please note that this tool has no function when the Universal algorithm is selected. You will notice
therefore that the corresponding blobs lack handles and that the Attack Speed field in the Note
Inspector for these blobs is grayed out.
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When you select the Attack Speed Tool, a white dot appears at the start of every note. If you now
place the tool anywhere on a note (not necessarily on the dot) and drag vertically, the dot will move
up or down.

If you move it upwards, the attack phase of the note will be compressed and play back faster, but the
rest of the note correspondingly more slowly. The note will therefore have a harder attack; its peak
amplitude will be reached more swiftly.

® '

If you move the point downwards, the opposite will occur. The beginning of the note will be stretched
— even beyond its visible starting point — and will play back more slowly, the rest, however,
increasingly rapidly. The attack will therefore be softer. Note that the position of the musical start of
the note indicated by the orange anchor is not affected by changes in attack speed. The ‘perceived’
start of the note is therefore independent of the attack speed. The end of the note is in all cases
unaffected.

You can vary the attack speed of notes individually, in order to accentuate them. You can also,
however, select and modify the attack speeds of multiple notes simultaneously and thereby alter the
timbre of an entire phrase.

If you double-click on a note or one of a selection of notes with the Attack Speed Tool, the
corresponding parameter will return to its neutral (central) position. The same result can be achieved
by choosing Edit > Reset Individual Edits > Time > Reset Attack Speed from the main menu.
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Combining time handles with the Attack Speed Tool

You can combine the use of time handles with that of the Attack Speed Tool. Altering the attack
speed in this case will cause the time handles to move, functioning as a kind of timing master. You
can therefore shape the evolution of the note to enhance the phrasing before adjusting the overall
timing (so that the note starts faster or more slowly) with the Attack Speed Tool.
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With the Note Separation Tool, you can cut notes as well as removing and moving note separations.
With the Separation Type Tool, you can switch between hard and soft separations.

Inserting, moving and removing note separations

Select the Note Separation Tool from either the toolbox or the context menu of the Note Editor or by
pressing the [F6] key of your computer keyboard. (If you wish to assign a different shortcut to this
tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the
main menu.)
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By double-clicking within a note with the Note Separation Tool, you can introduce a note separation
and thereby slice the note in two.
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Don'’t be surprised if the resulting pair of notes move apart in pitch; this is because as soon as the
fission occurs a new tonal center is calculated for each of the newly created notes, and their
respective tonal centers may differ from the tonal center the notes shared when they were one. In
such cases, each therefore moves to a new vertical position based on its newly calculated pitch
center.

You can move an existing note separation horizontally simply by dragging it with the Note Separation
Tool.

You can double-click a note separation to remove it.

Editing note separations with multiple notes selected

If you select several notes and move a note separation, the note separations of the other selected
notes will also be moved. If you double-click one of the note separations to remove it, the note
separations of the other selected notes will also be removed.
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If you have selected several notes that overlap, you can insert a note separation in the same place in
all of them simultaneously as well as move or remove one.

Soft and hard note separations

Depending upon the audio material and the algorithm selected, Melodyne places either soft or hard
separations between notes. Soft separations only occur between consecutive notes and provide a
link between the notes: if the end of the first note is moved, the beginning of the second note moves
along with it, to ensure that no gap opens between them. This helps you preserve phrasing when
editing.

The connection between notes also plays a role in the pitch, formant and amplitude transitions
between notes: such transitions are only possible in the case of connected notes between which a
soft separation exists.

In the case of a hard separation, consecutive notes are independent of one another. This means that
changing the length of the first note has no affect upon the position of the second. It also means there
are no pitch, formant or amplitude transitions between the two notes.

Soft separations are indicated by a thin vertical line between notes, whereas hard separations are
denoted by a bracket.
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Switching between hard and soft separations with the Separation Type Tool

The Separation Type Tool is the sub-tool of the Note Separation Tool. It allows you to toggle between
hard and soft separations. To select it, press the [F6] key (assigned by default to the note separation
tools) twice in quick succession. If you would prefer to use some other key combination, choose
Preferences -> Shortcuts -> Editing Tools -> Note Separation Tools and press the keys of your
choice. If you wish, you can define separate keyboard shortcuts for each of the two tools.

= | o l\_§_.|.,.._ (=S m-«l-ol

Double-click on a separation with this tool in order to change its type.
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Please note that it is only with certain separations that the option of switching freely between ‘soft’
and ‘hard’ exists.

® Soft separations can always be turned into hard ones.

® Hard separations, however, can only be turned into soft ones if they were soft to begin with
and their type has subsequently been changed. An exception to this rule is material detected
using the Percussive algorithm; in this case, all separations are initially hard but can be turned
into soft ones.

Separate Notes as Trills

When the Note Separation Tool is selected, you will find the command “Separate Notes as Trills” in
the Note Editor's context menu. The effect of this is to slice a selection of one or more notes into
smaller segments determined by the instantaneous pitch of each note. This is done by inserting note
separations into the slopes of the pitch curve as it rises and falls, thereby turning each ‘hill’ and each
‘valley’ of a vibrato into a separate note.

The use of this command allows you, for example, to improve the intonation of a trill, by tuning the
notes more closely to their intended pitches, or to rein in an unruly vibrato, by applying the Correct
Pitch Macro to its upper and lower extents.

Please note that the fluctuations in the Pitch Curve must be fairly pronounced for the “Separate Notes
as Trills” function to have any effect and that it is only available when the Melodic algorithm is active,
being grayed out in every other case. If you wish to assign a shortcut to the command “Separate
Notes as Trills”, this can be done using the Preferences dialog.

Separate Note

This command separates notes automatically at a point determined by Melodyne. It is useful when
you need to make precise cuts in a vocal passage and isolate sibilants or breathing noise prior to
editing using the tools.

You will find the “Separate Note” command in the context menu of the Note Separation Tool and on
the “Shortcuts” page of the Preferences property sheet, where you can assign a keyboard shortcut to
it.
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The Note Inspector

The Note Inspector in the info pane offers you an overview of the parameters of the selected note(s)

and allows you to alter the values.

The parameters of the Note Inspector

The Note Inspector brings together the inspector fields that are usually displayed near the toolbar
when the various tools are in use. It allows you to see all the most important parameters at a glance
and even edit them without having to change tools.

Track | Note | Project  File |

Pitch: A3
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: | 1000% |
| 1000% |
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In addition to the data included in the inspector fields, the Note Inspector displays the frequency in
hertz as well as a button for the muting of notes.

The editable parameters displayed in the Note Inspector are (from top to bottom):

® the pitch of the selected note in semitones, cents and hertz
® the pitch modulation expressed as a percentage

® the pitch drift expressed as a percentage

® the formant shift in cents

® the amplitude in decibels

® the button for muting and unmuting notes

® the attack speed expressed as a percentage
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Lower down in the inspector, you can see to which audio file the selected note belongs and which
algorithm was used for the detection.

Entering values and handling multiple selected notes

When only one note is selected in the Note Editor, the Note Inspector displays the concrete values for
that note.

As a general rule, you can modify all values either by clicking in their respective fields and dragging
the mouse pointer upwards or downwards or by double-clicking in the field and typing in a new value.

In the case of the Pitch field, you can enter either an absolute (C3, D4 etc.) or a relative (+2, -1, etc.)
value. In the other fields, it is always the absolute value that is adopted.

If you have selected multiple notes, the Note Inspector will only displays concrete values for
parameters if these are shared by all the selected notes. Where values differ, a dash “~" is displayed
in the relevant field.

If a dash is displayed, by clicking on it and dragging, you can alter the individual values of all the
notes selected by the same amount; in this way, for example, you could transpose an entire selection
up two semitones. The Scale Snap function, of course, if activated, will govern the eventual
destination of the various notes.

As you drag the values, Melodyne remembers the difference between them. This is even true when
certain parameters ‘collide’ with their maximum or minimum values; provided you keep the mouse
button pressed and drag then in the opposite direction, the initial difference will be restored. Only if
you release the mouse button at the point of collision will the initial difference be forgotten.

Alternatively, with multiple notes selected, you can type in a value that will then be assigned to, and
thereafter shared by, all the selected notes (whereupon the dash, of course, will disappear).

An exception here is the pitch, as, if you type in the value “2”, for example, all the selected notes are
shifted two semitones upwards. If you wish to assign the same pitch to all the selected notes, type in
an absolute value, such as “C2". If the Percussive or Universal algorithms are selected, of course, this
has no effect, as these algorithms only know relative pitch.
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To copy notes in Melodyne, first select the desired notes, then choose Copy from the Edit menu or
the context menu of the Note Editor. To insert them, use the Paste command. The following points
here need to be noted.

The selection, cursor and grid when copying

When you copy notes to the clipboard using the Copy command, you will notice that the cursor
moves to the start of the selection, or, to be more precise, to the quarter-note (crotchet) on the Time
Grid closest to the first note of the selection.

If, with the notes still selected, you use the Paste command, all that appears to happen is that the
notes that were selected prior to the paste are now no longer selected and the cursor is now located
just after the last of them.

In fact, however, the notes previously selected have been replaced by those on the clipboard. In other
words, the notes have been copied onto themselves, with the copies replacing the originals.
Admittedly, this may not sound particularly useful, but look at the position of the cursor: it is now
aligned with the quarter-note on the Time Grid closest to the last copied note.

115 15

If you now execute a further Paste, the notes on the clipboard will be pasted a second time. This time,
however, since no notes were selected, nothing will be replaced. Instead, the newly pasted notes will
end up just after those that replaced the originals the first time round.

Their position is now determined by the cursor. And since, after the first paste, this was aligned with a
quarter-note on the Time Grid (the first quarter-note after the pasted notes, to be specific), the effect
of the second paste is that the original alignment of the notes relative to the gridlines is reproduced
exactly, only further along the timeline. This behavior allows you to string together a succession of
copies of the same passage, quickly and accurately — in order, for example, to create multiple
iterations of a drum loop.
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Based on what we have just seen, we can formulate the following rules:
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® |f any notes are selected when the Paste command is executed, these are replaced by the
contents of the clipboard. The pasted notes are stretched or squeezed until they fit exactly the
range from the beginning of the first to the end of the last note of the selection. This is
illustrated here: on the left are the notes to be copied; in the centre, a single selected note,
which serves as the destination of the copy; on the right is the result after the paste is
performed: The selected destination note has been replaced and the pasted notes squeezed
just enough for them to fit exactly the space it occupied.
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® If when the Paste is executed no notes are selected, the cursor determines the point at which
the pasted passage begins. The grid settings here play an important role: when copying notes
to the clipboard, Melodyne remembers the distance between the first of the copied notes and
the nearest grid line. When the paste is repeated at the new cursor position, the offset of the
first pasted note to the gridline nearest to it will be exactly the same.
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In other words, notes in Melodyne are not copied in such a way that they necessarily coincide with
gridlines, because then the subtleties of expression would be lost. Instead, the notes copied retain
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their respective offsets to the grid. There is an exception, however, to this rule: if, instead of being
calibrated in beats, the grid is calibrated in seconds (i.e. if you have selected “Sec” from the Time
Grid Settings drop-down menu to the right of the Time Ruler), then the note (or first of a series of
copied notes) will begin exactly at the cursor position, with no offset.

® After each paste, the cursor is moved to the first quarter-note following the most recent paste,
making it easy to string together multiple iterations of the same passage. Obviously, if you
wish, you can move the cursor by hand to some other point on the Time Ruler and make that,
rather than the automatically selected quarter-note, the reference point for the next paste. You
might want to do this, for instance, to introduce a pause between iterations.

® The pitch of the copied notes is always the same as that of the originals. This is even true
when notes are selected, and therefore replaced, when the paste is performed. The length of
the passage selected, in this case, is retained but the original pitch of the notes it contained is
not. Of course, after performing the paste you can move the notes by hand to any pitches you
like.

Tempo adjustment when copying: the Auto Stretch Switch

If notes are selected when the paste is performed, the inserted passage will be stretched or squeezed
to fill the available space (i.e. that between the beginning of the first selected note and the end of the
last) as we have already seen. But how is the tempo of the copied passage treated when the position
of the paste is determined instead by the cursor?
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If the tempo at the destination of the paste is different from that of the passage from which the notes
were copied, it is the status of the Auto Stretch Switch that determines whether the pasted notes
adjust to the tempo of the destination or retain their original tempo. If the Auto Stretch Switch is on,
they adjust; if it is off, they do not. So unless you want to change the tempo at the cursor position, you
should switch Auto Stretch on before performing the paste.

If the tempo of the source is different from that of destination, and the material on the clipboard is
adjusted to the new tempo, the pasted version will obviously sound different to the original. If you
want to avoid this happening, however, in the stand-alone implementation of Melodyne, you can copy
not only the notes but also the tempo (including any sudden or gradual tempo changes within it) from
the source to the destination. In this case, it makes no difference which you copy first: the notes or
the tempo.
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The Edit menu

Melodyne’s Edit menu includes items that allow you to reset individual edits and add random
deviations to the audio material.

Resetting edits

The Reset Individual Edits sub-menu contains commands that nullify the effects of various types of
editing.

You will also find in the context menu of the Note Editor whichever of these commands are relevant to
the tool you are using at the time.

Delete @l

e

Pitch > HE
Add Random Deviations > Formants >
Quantization Macros > Amplitude >
Time >

Select Al A Restore File to Original State
Select Special > . .

The commands invariably apply to the current selection and are grayed out if no editing of the type in
guestion has yet been applied to the selected notes. Notice that these reset commands work
independently of the normal undo function.

The effect of the following types of editing can be reversed via the Reset Individual Edits sub-menu:
Pitch

® all changes of pitch
® editing of the pitch center
® editing of pitch modulation
® editing of pitch drift
® editing of pitch transitions

Formants

® editing of formants
® editing of formant transitions

Amplitude

® editing of amplitude
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® editing of amplitude transitions
® the muting of notes

® all editing of timing (start position / length of notes)
® the placing of time handles
® editing of the attack speed

The final command, Restore File to Original State, reverses in one go the effects of all editing
(regardless of type) that has been performed on the audio file.

Adding random deviations

The Add Random Deviations sub-menu varies the pitch or timing of individual notes a) drastically, b)
by a moderate amount, or ¢) in a subtle way; within these various limits, the direction and extent of
the deviation is determined randomly.

wvoiowo At}
Reset Individual Edits » 10 Lk [12
Pitch: Drastic
Quantization Macros > Pitch: Moderate
Pitch: Subtle
Select All A
Select Special = Timing: Drastic
Timing: Moderate
Tempo . Timing: Subtle

The commands introduce random variation to either the pitch or the timing of the selected notes, and
their effect, if the command is used several times in succession, is cumulative.

Random deviations are particularly useful when you have made one or more copies of a single take
but do not wish them to be identical either to each other or to the original — the object being, perhaps,
to make a single vocalist sound like a choir. Through the addition of a certain amount of random
deviation to each copy you can obtain more natural-sounding results by ensuring that the
synchronization of the individual voices is never improbably perfect and that no two copies exhibit
identical fluctuations in pitch.
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From this tour, you will learn how to save audio notes in Melodyne as MIDI notes.

About Audio-to-MIDI

Melodyne allows you to export audio notes as MIDI notes. When this is done, a file in Standard MIDI
file format is created and saved to your hard disk. This file can then be loaded into your DAW, so you
can use it, for instance, to double your vocals with a sound from a software synthesizer.

The MIDI notes are an exact representation of the audio notes in Melodyne. For each audio note, a
MIDI note is created with the same position, length and pitch. The velocity of each MIDI note is
derived from the amplitude of the audio note it represents.

When you save rhythmic material as MIDI, all the MIDI notes will share the same pitch but take their
position, length and amplitude from their audio equivalents in the rhythm track. You can use this
technique, for example, to derive from a drum loop a quantization reference for other MIDI tracks in
your DAW.

The generation of MIDI notes from audio material offers a wealth of different creative possibilities. Try
it out for yourself!

Exporting MIDI

To perform the export, select Save as MIDI ... from the Settings menu. In the file selection box that
appears, you can enter a name and a storage location for the MIDI file.

The export will begin at the start of Bar 1, even if the first notes appear in a later bar. This will ensure
that the MIDI notes in your DAW will run in sync with the original audio notes; simply drag the MIDI
file onto a track beginning at Bar 1.

If you opt for the Cycle Range Only option, only the notes within the cycle range will be exported. This
is useful if, for instance, you wish to save as MIDI some specific segment such as a single phrase or
bar.

Please note that the option Cycle Range Only refers to the cycle range in Melodyne not in the DAW.
You can set the cycle range in Melodyne while playback in the DAW is stopped. The default cycle
range in Melodyne is the area of the timeline covered by the first transfer. If this default cycle range is
adopted as the range of a subsequent transfer, it may be that Melodyne will round it up to the nearest
bar to make positioning the resulting MIDI file easier.
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The MIDI file exported by Melodyne also contains tempo information. Most DAWSs give you the option
of either adopting this tempo information or ignoring it in favor of the current tempo in the DAW itself.
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Normally the bar rulers of your DAW and the plug-in implementation of Melodyne will always be in
sync. If, however, there is a tempo change in your DAW between two track segments that you have
transferred to Melodyne, or if you have altered the overall tempo in your DAW after transferring
material to Melodyne, you must inform Melodyne of such changes so that synchronicity between the
bar rulers of the two programs can be restored.

A new constant tempo

Whenever Melodyne registers a tempo change in the DAW, the button near the tempo display will
flash to indicate that a matter requires your attention. If you do nothing, you resign yourself to there
being a discrepancy between the bar ruler in the DAW and that of the Melodyne plug-in.

125 @ d L3

Click the button to open the tempo dialog. Here you can inform Melodyne of the nature of the tempo
change it has detected, in order to ensure that the two bar rulers remain in step.

Melodyne detected a change of tempo in your DAW. ——
Is the new tempo supposed to be constant or variable?

Constant 124.000 BPM —
Variable

V/Stretch/Squeeze Audio

Import... Cancel OK

If you have simply changed the overall tempo and there are no tempo changes within the song itself,
select Constant Tempo. This tells Melodyne that the new tempo registered applies to the entire song
and that it should adjust its own bar ruler accordingly.

If you want Melodyne to stretch or compress the audio material to reflect the new tempo, check the
box below.

If you select this option, Melodyne will employ time-stretching (or -compression) to adjust the material
already transferred to the new tempo. If your DAW performs its own time-stretching on audio material
when there is a change of tempo, Melodyne will behave exactly the same way whenever this box is
checked, so the audio material in the DAW and the plug-in will remain in sync.
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If your DAW does not employ time-stretching and merely changes the grid beneath the audio material
when tempo changes occur, to ensure identical behavior in Melodyne clear the check box in question.
Of course, even in this case you may prefer to check the box, in order to achieve through Melodyne
what with your DAW you cannot, hamely an adjustment of the audio material to the new tempo by
means of time-stretching.

A new variable tempo

If you have not selected a new constant tempo in your DAW but simply introduced an internal tempo
change (whether sudden or gradual), select Variable Tempo.

Melodyne is perfectly capable of registering tempo changes and implementing them correctly without
any assistance, but it can only do so if they occur within a passage that has been transferred to it. If a
variation in tempo occurs between two transferred passages, Melodyne is obviously in the dark.

The simplest way of informing Melodyne about such tempo variations is to save from the DAW a
standard MIDI file that runs from Bar 1 to the end of the project and then load it using the Import
button in the tempo dialog. This will provide all instances of Melodyne with the information they need
concerning the tempo variations in the DAW project. The synchronicity of the two bar rulers will
therefore be assured.

A second way of doing it is to play through to Melodyne the passage containing the variations in
tempo so that it can analyze them. It is enough to play the passage through to a single instance of
Melodyne as the other instances will be informed of the tempo changes automatically.

To do this, proceed as follows (heeding also the advice in the following section):

® While the tempo dialog is open, stop the playback in the DAW and move its playback cursor to
a point in the timeline about one bar prior to the start of the new tempo acceleration or
deceleration

® Next, for the benefit of Melodyne, play through the entire passage until the acceleration or
deceleration comes to an end and a constant tempo has been maintained for at least one bar.

* Now stop the playback in the DAW. In the tempo dialog, you will see indicated the range of the
tempo variation within the passage concerned. The tempo displayed here is somewhat more
precise than that shown in the tempo field, so do not worry if there is a small discrepancy
between the two values.

Note: Some DAWSs (at present only Cubase) are capable of keeping Melodyne informed of changes
in tempo. Since Melodyne in their case already has the information it needs, the minimum and
maximum tempos within the passage in question will be displayed automatically as soon as the
tempo dialog is opened and there is no need to play through the passage in question. Just click OK to
close the dialog.
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Melodyne detected a change of tempo in your DAW. —
o Is the new tempo supposed to be constant or variable?
Constant h—
Variable 106.791 BPM - 117.206 BPM 7
V/Stretch/Squeeze Audio
Import... Cancel OK

l

Specify once more whether you want the audio material itself or only the grid to be stretched or
compressed to reflect the tempo variations.

Exit with OK to apply your settings or Cancel to discard them. The OK button will remain greyed out
until you have started your DAW to play the tempo change through to Melodyne and then stopped it
again.

Important when working with variable tempo

If Melodyne has not been fully informed of changes in the tempo or time signature, the time rulers of
the DAW and Melodyne can get out of sync and transfers will sound at the wrong time or be recorded
in the wrong place.

The handling of variable tempo is unfortunately not self-explanatory. It would be far simpler if DAWs
transmitted all information about changes in tempo or time signature to plug-ins, but, sadly, the plug-
in interface at the moment does not provide for this. Melodyne is therefore obliged to obtain all the
relevant information from the material transferred. However, since transfers as a rule do not extend
the full length of the song, the tempo dialog makes it possible for Melodyne to analyze changes in the
tempo or time signature during pure playback — in other words, without any transfer being necessary.
With respect to Melodyne’s analysis of the tempo, if the following rules are observed, everything
should go as expected and there is no reason why you should not be able work successfully with
variable tempo.

® Prior to the first transfer, with the tempo dialog open, play through to one instance of Melodyne
the entire song including all passages in which the tempo accelerates, decelerates or
changes abruptly or in which there is a change of time signature. This will allow Melodyne to
create a tempo map, which will be adopted by all instances of Melodyne. Alternatively, using
the Import key you can load a standard MIDI file exported previously from the DAW containing
the requisite tempo data. If in doubt, use this method, which is described above, as it is quicker.

* If you have made further changes to the tempo in the DAW, play through once again to one
instance of Melodyne in the tempo dialog the entire song. This will allow Melodyne to map all
the tempo changes and preserve the synchronism of the bar ruler.
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® |f, prior to changing tempo progressions in your DAW you have already transferred material to
Melodyne, then once Melodyne has learned about the changes, before closing the tempo
dialog check the Audio Stretching option. This is the only way of ensuring that the material
already transferred can adapt to the new tempo environment.
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Here you will find an overview of all changes introduced by the most recent Melodyne updates.

New in Melodyne 4.2.3

® Fixed: In Version 4.2.2, Melodyne in certain configurations displayed the message “expired” at
start-up and refused to launch.

New in Melodyne 4.2.2

New functions and improvements

Better window management in Studio One 4: Melodyne’s zoom and other window settings now
remain constant when you select a new audio region, instead of being displayed with individual
settings as previously.

Bug fixes

® Fixed: In Cakewalk, under certain circumstances, instead of new files being analysed
automatically, you had to select an algorithm manually in order to trigger the detection process.

® Fixed: In the stand-alone implementation of Melodyne, closing a project without saving
sometimes led to a crash if other projects were open at the time.

® Fixed: In Logic, validating the Melodyne plug-in sometimes slowed down the launch of the
DAW.

® Fixed: In the stand-alone implementation of Melodyne, opening or importing projects under
certain circumstances led to a crash.

® Fixed: In ARA mode, it could happen under certain circumstances that the monitoring during
blob editing no longer functioned after starting and stopping playback.

® Fixed: In Cakewalk, selecting a new clip sometimes led to a misalignment of the Melodyne
position display.

New in Melodyne 4.2.1

New functions and improvements

Faster loading with ARA: In DAWSs with ARA support, extensive projects now load considerably
faster.

Bug fixes
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® Fixed: During ARA operation with Mixcraft and Cakewalk, blob monitoring and scrubbing were
no longer available in Melodyne if you started playback in the DAW.

® Fixed: With Melodyne in Player Mode (i.e. without activating the program on the computer
being used), the ARA plug-in sometimes crashed when you switched from Track Edit Mode to
Clip Edit Mode.

® Fixed: If the detection was aborted after a transfer with the Melodyne plug-in and you
subsequently tried to move audio material whilst holding down the ALT key, a crash was
sometimes the result.

® Fixed: If an audio file was selected in the track pane of the stand-alone implementation of
Melodyne studio, adjusting the fine tuning in the inspector sometimes led to a crash.

New in Melodyne 4.2

Thanks to ARA, now more fully integrated: Melodyne and Logic

Thanks to ARA Audio Random Access, Melodyne 4.2 and Logic Pro X 10.4.3 work more closely and
efficiently together. Here are the most important workflow advantages in a nutshell.

You can open tracks without transfers: Just load Melodyne as an insert effect, start playback and
the entire track will appear automatically in Melodyne. There is no further need for transfers.

Melodyne follows all changes you make to the track: Melodyne compares its contents to those of
the audio track and accurately replicates any lengthening, shortening or movement of regions.

Real copies and ghost copies of regions: When regions are copied, looped or cloned, the
Melodyne content behaves accordingly as a real copy or as a ghost copy (Loop).

Region-based mixing: Regions edited with Melodyne now support all the mix functions of the region
inspector in Logic: Region, Gain, Mute and Fades.

You can use Melodyne as early as the comping stage: Now you can edit takes with Melodyne
before committing yourself to a choice between them, which gives you a more realistic assessment of
their respective merits, leading to better results.

The management of transfer files is a thing of the past: Thanks to ARA, there is no need anymore
to keep transfer files in mind and archive them or pass them on to collaborators.

More...
New functions and improvements

ARA in Logic: Melodyne 4.2 supports ARA integration into Apple’s new Logic Pro X 10.4.3. With
ARA, transfers are no longer necessary in Logic, and Melodyne follows all changes made to the
audio track.
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The transfer path in Cakewalk/Sonar: When using the Melodyne VST3 plug-in in Cakewalk/Sonar,
the transfer path is now created automatically within the current project (Cakewalk Projects / <project
folder> / Melodyne / Transfers).

Improved interaction: Melodyne 4.2 interacts even better with Studio One and now requires Studio
One Version 3.5.6 or later.

Additional keyboard shortcut: You can now assign a keyboard shortcut from the Preferences
dialog for the command “Reseparate Notes at Starting-Point Lines” that appears in the context menu
in Note Assignment Mode; the shortcut is then also available in edit mode.

Bug fixes

® Fixed: In Studio One, in projects with many Melodyne clips, the generation of additional
Melodyne instances (using the command “Open in Melodyne”) sometimes slowed down the
program.

® Fixed: In Studio One under Windows, the color of the note background used to change when
you altered the zoom level.

® Fixed: In Studio One, the function “Unison Spread” sometimes shifted the notes in Melodyne
several octaves.

® Fixed: In Studio One, use of the Note Separation Tool under certain circumstances led to a
crash.

® Fixed: In Studio One, the note display (the lines superimposed on the waveform) was
previously not updated when notes were deleted in Melodyne.

® Fixed: In Studio One, in the case of copied events, “Follow Clip Selection in the DAW” resulted
in the wrong bars being shown.

* Fixed: In Cakewalk/Sonar, the export of a 16-bit audio file edited with Melodyne sometimes led
to a crash.

® Fixed: In Cakewalk/Sonar, use of the Freeze function sometimes led to a crash.

® Fixed: In all DAWSs with ARA, changes to the key or scale were previously not saved.

® Fixed: In all DAWSs with ARA, use of the Compare switch stopped local playback in Melodyne.

® Fixed: In Logic 10.3, the opening of some projects with Melodyne could lead to a crash.

® Fixed: In Digital Performer, the opening of projects previously edited with Melodyne sometimes
led to a crash.

® Fixed: In the plug-in, the command “Restore File to Original State” could under certain
circumstances result in the wrong notes being deleted.

® Fixed: Canceling a transfer could lead to a display error or even (if you proceeded with editing
) to the DAW crashing.

® Fixed: In the plug-in, the assignable keyboard shortcut “Repeat Last Menu Action” did not work.

®* Fixed: If the Scale Window was open when you switched from edit mode to Note Assignment
Mode, the wrong area of the timeline used to be displayed.

* Fixed: In the Sound Editor, no peak values were displayed for the spectrum when Note
Assignment Mode was active.
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® Fixed: In Melodyne studio’s track list, the “Edit” and “Reference” buttons could both be
activated by Alt-clicking.

® Fixed: In Melodyne studio, when multiple tracks were copied simultaneously, their contents
were sometimes swapped.

®* Fixed: In Melodyne essential, the assignable keyboard shortcut for “Separate Notes as Trills”
was missing.

®* Fixed: In Melodyne essential, opening a document saved by Melodyne studio sometimes
resulted in the wrong track being displayed.

®* Fixed: In the stand-alone application, it was impossible to copy and paste notes in Tempo
Assignment Mode.

® Fixed: In the stand-alone application, a new detection sometimes led to the audio being offset
in the timeline.

® Fixed: In the stand-alone application under macOS Version 10.12, crashes sometimes
occurred when the import audio function was used.

New in Melodyne 4.1.1

New functions and improvements

The “Separate Note” command

This command separates notes automatically at a point determined by Melodyne. It is useful when
you need to make precise cuts in a vocal passage and isolate sibilants or breathing noise prior to
editing using the tools.

You will find the “Separate Note” command in the context menu of the Note Separation Tool and on
the “Shortcuts” page of the Preferences property sheet, where you can assign a keyboard shortcut to
it.

A shortcut for the command " Separate at Starting Point Lines”

From the “Shortcuts” page (heading: “Note Assignment”) of the “Preferences” property sheet, it is now
possible to assign a keyboard shortcut to the command “Separate at Starting Point Lines” that is used
in Note Assignment Mode; this command could previously only be accessed from the context menu
of the Note Separation Tool.

Bug fixes

® Fixed: graying out under certain circumstances of the buttons used to open the macros

® Fixed: occasional crashes when the Note Separation Tool was used in Note Assignment Mode
and the threshold value was altered

® Fixed: alteration under certain circumstances of the length of an audio file when saving

® Fixed: crashes occurring in rare cases when multiple recordings followed in quick succession

® Fixed: crashes occurring in certain circumstances with Logic Pro 10.3.1 under macOS 10.12.x
and 10.11.x

® Fixed: crashes coincident with the opening of some projects with Logic 10.3
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® Fixed: crashes occurring sometimes in Sonar when an ARA region was frozen

® Fixed: occasional interruptions of the simultaneous transfer of four or more tracks with Digital
Performer 9.13 under macOS 10.11.6

® Fixed: memory leak with FL Studio

New in Melodyne 4.1

The update brings important improvements to all editions of Melodyne, including a new playback type
for high-pitched monophonic instruments, a command for separating notes as trills and additional
keyboard shortcuts. When Melodyne is integrated into the DAW by means of the ARA interface
extension, user-friendly new possibilities are now available for vocal comping, and in Melodyne 4
studio, the simultaneous editing of an unlimited number of tracks can now be done via ARA, too.

In ARA-compatible DAWSs, Version 4.1 offers decisive improvements that make it possible to focus
Melodyne’s functions in an optimal manner on an individual clip or an entire track. In Clip Mode, you
have access to a single clip, but this extends to notes lying beyond its borders; as a result, when
comping it is very simple to solve any problems posed by clip borders slicing notes in two, which
greatly streamlines the comping workflow. In Track Mode, on the other hand, you see all clips of a
track exactly as these are cut and arranged in the DAW. The two modes complement each other
perfectly and offer ideal editing possibilities in ARA-compatible DAWS.

When Melodyne is integrated into a DAW by means of ARA, Version 4.1 now allows the simultaneous
display and editing of an unlimited number of DAW tracks in a single Melodyne plug-in window — ideal
for backing vocals and other multitrack applications.

The ARA Audio Random Access interface extension, which is currently supported by Presonus Studio
One, Cakewalk Sonar, Magix Samplitude and Tracktion, makes the use of Melodyne particularly fast
and efficient. DAW tracks can be edited directly without any time-consuming transfers; furthermore,
Melodyne follows automatically any changes made to the tracks. The result is that Melodyne feels like
a comfortable integrated sample editor — but one that allows the note-based editing of tracks.

New functions and improvements

Multitrack Note Editing now also during ARA integration
In Melodyne studio 4.1's Note Editor, you can now also with ARA integration display and edit as many
DAW tracks simultaneously as you like.

ARA improvements for (vocal) comping in the DAW

Thanks to two new ARA modes, Melodyne’s power can be optimally focused on an individual clip or
an entire track, thereby providing ideal support for typical DAW workflows such as (vocal) comping:
ARA Clip Mode affords access to a single clip but also to notes on either side of the clip borders. ARA
Track Mode, on the other hand, shows you all the clips on a DAW track, exactly as they are edited
and arranged there.
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New playback type for monophonic instruments
To enhance sound quality during the playback of soprano voices or very high-pitched melodic
instruments (e.g. piccolos), the Algorithm Inspector now includes a new playback type: “Tonal (high)”.

The “Separate Notes as Trill” command
The Note Editor and Note Assignment Mode now feature Melodyne studio 3’s familiar “Separate
Notes as Trill” command.

The “Separate Note” command

This command separates notes automatically at a point determined by Melodyne. It is useful when
you need to make precise cuts in a vocal passage and isolate sibilants or breathing noise prior to
editing using the tools.

A shortcut for the command "Separate at Starting Point Lines"

From the “Shortcuts” page (heading: “Note Assignment”) of the “Preferences” property sheet, it is now
possible to assign a keyboard shortcut to the command “Separate at Starting Point Lines” that is used
in Note Assignment Mode; this command could previously only be accessed from the context menu
of the Note Separation Tool.

The “Replace Audio” command
The “Replace Audio” command allows you to save an audio file under its existing name without
having to open the Export dialog.

Better keyboard shortcuts
Every sub-tool now has its own independent shortcut. A shortcut has also been added for the Time
Grid, and Zoom commands assigned to the numerical keypad.

Contrast variations for the user interface
In the Preferences dialog, several new contrast options are available for the user interface.

HiDPI support under Windows

On suitable systems running Windows 8 or later, Melodyne now supports the high resolution screen.
This applies to both the stand-alone implementation and the plug-in in Studio One. HiDPI support for
further DAWSs is planned.

Reduced memory requirements
Thanks to internal optimization, the memory requirements under Windows in particular of Melodyne
4.1 (stand-alone, plug-ins and ARA) have been reduced.

Auto Scroll options
When running Melodyne as a plug-in, you can now save separate Auto Scroll settings for each
instance.
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iLok
In addition to the iLok 2, Melodyne 4.1 now supports the new iLok 3.

Bug fixes

® Fixed: under Windows 7, certain MP3 files when loaded causing Melodyne stand-alone to
crash

® Fixed: in Cubase, the setting “Always on Top” for the plug-in window sometimes leading to a
crash

® Fixed: various graphics problems in the plug-in

® Fixed: entered or detected tonalities reset to C Major when saving

® Fixed: MAR files from Melodyne studio 3 imported by Melodyne 4 with incorrect tempo
information

® Fixed: sundry other problems affecting the import of studio 3 files

® Fixed: shift by a few samples of audio material after a later change of algorithm

® Fixed: occasional misalignment of the Time Grid after tempo learning in the DAW

® Fixed: unreliable transfer to the Melodyne plug-in of information regarding changes of time
signature in Cubase’s Learn Tempo dialog

® Fixed: crashes occurring in certain circumstances with Logic Pro 10.3.1 under macOS 10.12.x
and 10.11.x

® Fixed: crashes coincident with the opening of some projects with Logic 10.3

® Fixed: occasional crashes when the Note Separation Tool was used in Note Assignment Mode
and the threshold value was altered

® Fixed: alteration under certain circumstances of the length of an audio file when saving

® Fixed: crashes occurring sometimes in Sonar when an ARA region was frozen

® Fixed: graying out under certain circumstances of the buttons used to open the macros
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Switching to Melodyne studio trial mode

Explore all the possibilities Melodyne has to offer! To do this, simply switch your Melodyne essential,
assistant or editor to Melodyne studio trial mode. If you do not have Melodyne, you can download the
trial version here.

Switching to trial mode

When you switch to trial mode, your Melodyne essential, assistant or editor will be transformed for 30
days — free of charge and without obligation - into Melodyne studio, the largest Melodyne edition,
which contains the full range of Melodyne functions. You can use all these functions for 30 days
without restriction, exactly as if you had purchased Melodyne studio. Trial mode can only be activated
once on the same computer. To switch to trial mode, and each time you launch Melodyne studio
during the trial period, you will need an Internet connection.

Here’s how to activate trial mode:
1) Start Melodyne. Next go to the Help menu and select “License”.

In the plugin:

Jptions m

[ Open Help Center...

Contact Support... . ‘:: ‘{b‘ \k 1% |
Check for Updates... —
i ‘ License (Upgrades, Trial, etc.)... k! 3

About...

—] g

] fn

In the stand-alone implementation:

pns Window m

Open Help Center...
Contact Support...

Check for Updates...

License (Upgrades, Trial, etc.)...

i m07 0”0 10 111 12 113 Im1a I0mR I0n
2) You will be directed to your user account in your browser where you will see your license options.
In the “Melodyne studio trial mode” frame, switch to trial mode:
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Switch to trial mode

Click here to switch on Melodyne 4 studio trial mode. This will allow
you to explore all the functions of Melodyne 4 studio — free of charge
and without obligation, but exactly as if you'd purchased it - for a

period of 30 days <

That's all there is to it. Trial mode will remain active for 30 days, so when you return now to Melodyne
you will see that the “Melodyne studio” edition is running.

Comparing editions

If you wish, you can switch to a smaller edition in the course of the trial period in order to compare the
range of functions offered by the various editions. This could be useful, for instance, if you own
Melodyne essential and are wondering which of the larger editions to upgrade to. Easy. Just try them
all.

To switch editions, select “License” from the Help menu exactly as before. This will take you back to
your user account in your browser, where you will be given the option of switching to one of the
smaller editions.

Chanae editions
wna Yo CUiiuln o

Here, you can switch temporarily to the trial version of a smaller edition

of Melodyne to compare the range of functions .

Your choice, however, will only remain effective while Melodyne is actually running. As soon as you
restart Melodyne, the full Melodyne studio function set will be restored.

Expiry of the trial period

At the end of the 30-day trial period, Melodyne will automatically revert to your previous edition.
Further editing of projects created during the trial period will still be possible, but only using the
functions of your previous Melodyne edition. Playback, however, will be unaffected, so none of the
work you did during the trial period will be lost.

Convinced?

If you wish, you can switch permanently to Melodyne studio at any time during the trial period or
thereafter. The requisite upgrade can be obtained from our web shop or from your local dealer.
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If you have problems, you will find advice here. Additional topics can be accessed by clicking on
“FAQ” in the side menu.
If the tips do not help contact support@celemony.com. Our support staff speaks English and German.

I'm not sure how to install Melodyne correctly.

Just run the installation program that you received as a download or that you will find on your
Melodyne CD. This will install both the stand-alone implementation of Melodyne and the various plug-
ins onto your computer.

| have installed Melodyne but cannot find it.

Under macOS, the stand-alone implementation of the program is called “Melodyne”. You will find it in
the “Melodyne” subfolder of the “Applications” folder. The plug-ins are also called “Melodyne” and you
will find them in: Macintosh HD/Library/Audio/Plug-Ins/<Subfolder of the plug-in type in question>.
Under Windows, the stand-alone implementation is called “Melodyne.exe”. You will find it under
C:/IPrograms/Celemony/Melodyne/ or C://Program Files (x86)/Celemony/Melodyne/. The various plug-
ins are also called “Melodyne” and are generally to be found here;

VST3 (64 Bit): C://[Programs/Common Files/VST3/Celemony

VST3 (32 Bit): C://Program Files (x86)/Common Files/VST3/Celemony

VST2 (64 Bit): C://[Programs/Common Files/Steinberg/VST2/Celemony (the path can be chosen at
the time of the installation; please check to see which path your DAW is using)

VST2 (32 Bit): C://Program Files (x86)/Steinberg/VSTplugins/ (the path can be chosen at the time of
the installation; please check to see which path your DAW is using)

AAX: C://Programs/Common Files/Avid/Audio/Plug-Ins

RTAS: C://[Program Files (x86)/Common Files/Digidesign/DAE/Plug-Ins

In your DAW, you will find Melodyne among the audio effects plug-ins. To use it, insert the plug-in into
the desired audio tracks.

I've installed Melodyne but do not know how to activate it.

Launch the stand-alone implementation of Melodyne. In the dialog box that appears, click on
“Activate”. This takes you online to our registration page, where you can create a user account if you
do not already have one. To do this, follow the onscreen instructions. When you have finished, your
computer will be activated and you will be able to run Melodyne on it permanently and without
restrictions. If you purchased Melodyne from our web shop, it is enough to click on “Activate”, as you
will already have created your user account at the time of the purchase.
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| am getting error messages and cannot complete the activation.

To activate the program, you need a working Internet connection. Make sure — e.g. by trying to
access another web site — that you are actually online. If you are, restart Melodyne and try again.

I would like to install Melodyne again but no longer have the installation program.

You will find your personal installation program in your user account. Log in at www.celemony.com
/login and download it to reinstall Melodyne.

I'm not sure whether the right edition and version of Melodyne is running.

To discover which edition and version number of Melodyne is running, choose “About Melodyne” from
the main menu. If you need it, you will find the installation program for the Melodyne edition
corresponding to your license in your user account (www.celemony.com/login).

I would like to know whether an update is available for my Melodyne.

Melodyne checks automatically via the Internet whether a newer version is available. You will find this
function on the “Check for Updates” page of the Preferences dialog where you can also check for
updates manually by clicking “Check Now”. We also provide information about updates in our
newsletter, to which you can subscribe from your user account (at www.celemony.com/login).

I cannot launch the stand-alone implementation of Melodyne.

Restart your computer, then make a further attempt to launch Melodyne. If that does not work, delete
your Melodyne preferences (instructions below) and try again. If Melodyne still will not launch, please
contact our support at support@celemony.com. You will find your Melodyne preferences here:

» macOS: Hold down the Alt key in Finder and from the main menu choose Go > Library and open the
Preferences subfolder. Scroll down to the file “com.celemony.melodyne.pref.plist” and delete it.

» Windows: Navigate to C://Users/<Your user name>/AppData/Roaming/Celemony/ and delete the file
“com.celemony.melodyne.plist”. If the “AppData” folder is not visible, open the Control Panel by
clicking the Start button (Windows 7) or right-clicking in the bottom left-hand corner of the screen
(Windows 8). Now choose “Appearance and Personalization” followed by “Folder Options”. Click on
the View tab. Under “Advanced Settings”, check “Show hidden files, folders, and drives” and exit with
OK.

I have inserted Melodyne as a plug-in in one of the audio tracks of my DAW but nothing
is happening.

Initially Melodyne is empty; before it can do anything, audio material has to be transferred to it from
the relevant track of the DAW. To do this, click the Transfer button in Melodyne and then, from the
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DAW, play the passage you wish to edit. Once you have finished the transfer, the notes will appear in
Melodyne and you will be able to edit them.

I have the impression that my DAW and Melodyne are not interacting correctly.

Many DAWSs have particular characteristics of which you need to be aware, such as whether or not
they support the ARA interface extension. In our Help Center, you will find the required information
and tips on all leading DAWSs. You can reach our Help center from Melodyne’s Help menu or under
www.helpcenter.celemony.com.

| am not getting any audio output with the stand-alone implementation of Melodyne.

Open the Audio page of the Preferences dialog and make sure that the correct audio device is
selected. Under macOS that should be the built-in audio hardware or your audio interface (and not,
for example, the wireless interface Airplay). Under Windows, please select the correct ASIO driver.
With DirectX no recording is possible.

After transferring or importing audio, the blobs in Melodyne are not at all as | expected.

By default, Melodyne selects an algorithm for your audio material automatically. It can happen from

time to time that monophonic material is interpreted as polyphonic. If this happens, click on a note in
the affected passage and select from the main menu under “Algorithm” an algorithm better suited to
your purpose.

Sometimes, | can only move the blobs in the Note Editor vertically, sometimes only
horizontally.

If you are editing a blob using the Main Tool (the arrow symbol), it is the initial direction of the drag
that determines whether the blob can be moved vertically or horizontally. Release the blob
momentarily if you wish to change direction. If the Pitch or Time grid is active, you will need to hold
down the Alt key to make fine adjustments in the dimension concerned. When moving blobs
horizontally, remember that it makes a difference whether you begin dragging from the middle of the
blob or from either the beginning or the end. In the former case, the whole blob is moved; in the latter,
only the beginning or end.

When | shift the pitch of certain blobs, they sound unnatural.

Occasionally, in the detection of monophonic audio material, octave errors can occur, and in that of
polyphonic audio, prominent overtones can be mistaken for separate notes. In such cases, when the
corresponding blobs are moved, artifacts can arise. You can prevent this by checking, and if
necessary editing, the detection in Note Assignment Mode before you start, to ensure that the notes
displayed really do correspond to those actually played.
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In the stand-alone implementation, the tempo of an imported audio file is wrong.

Activate the Auto Stretch switch to adapt the file you are importing to the project tempo. Deactivate it
if you wish the original tempo of the imported file to be retained. If, in the former case, the tempo of
the imported file is still wrong, open the file first in a separate project document and correct the tempo
assignment there before copying the blobs into the first project.
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